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NỘI DUNG 1: Một số vấn đề về ứng dụng CNTT trong phát triển tài liệu bồi 

dưỡng chuyên môn cho GVMN 

1.1. Yêu cầu đối với tài liệu bồi dưỡng chuyên môn cho GVMN 

1.1.1. Tài liệu bồi dưỡng chuyên môn cho GVMN 

Thông tư số 19/2019/TT-BGDĐT1 ngày 12/11/2019 và số 17/2022/TT- 

BGDĐT2 ngày 5/12/2022 của Bộ Giáo dục và Đào tạo đã qui định rõ các hoạt 

động liên quan đến công tác bồi dưỡng thường xuyên giáo viên, cán bộ quản lí 

cơ sở giáo dục mầm non, cơ sở giáo dục phổ thông và giáo viên trung tâm giáo 

dục thường xuyên. Phần này trích dẫn một số nội dung liên quan đến các loại 

hình tài liệu bồi dưỡng phù hợp với loại hình tổ chức bồi dưỡng là tập trung, từ 

xa hay bán tập trung và yêu cầu đối với tài liệu bồi dưỡng. 

Các yêu cầu đối với tài liệu bồi dưỡng là: 

- Tài liệu được biên soạn phù hợp với yêu cầu bồi dưỡng giáo viên, cán bộ 

quản lí theo chuẩn nghề nghiệp, vị trí việc làm, yêu cầu đổi mới và nâng cao chất 

lượng dạy học, giáo dục phù hợp với kế hoạch bồi dưỡng và nhu cầu phát triển 

nguồn nhân lực của cơ sở giáo dục mầm non, cơ sở giáo dục phổ thông, trung tâm 

giáo dục thường xuyên, của địa phương và của ngành; 

- Tài liệu phải bảo đảm kết hợp giữa lí luận và thực tiễn; kiến thức, kinh 

nghiệm và kĩ năng thực hành; tích hợp, lồng ghép các chương trình bồi dưỡng 

có nội dung tương đồng; không được trùng lặp. Chương trình, tài liệu phải 

thường xuyên được bổ sung, cập nhật, nâng cao phù hợp với tình hình thực tế; 

- Tài liệu biên soạn phải phù hợp với chương trình bồi dưỡng; 

- Tài liệu được tổ chức biên soạn phù hợp với loại hình tổ chức bồi dưỡng; 

+ Tài liệu bồi dưỡng tập trung: Được tổ chức biên soạn và phát hành dưới 

dạng ấn phẩm, băng tiếng, băng hình và các thiết bị lưu trữ thông tin khác đảm 



bảo theo quy định của chương trình bồi dưỡng và các quy định khác; 

+ Tài liệu bồi dưỡng từ xa: Được biên soạn dưới dạng học liệu (băng đĩa 

ghi hình ảnh, âm thanh, đoạn phim ngắn; chương trình phát thanh, chương trình 

truyền hình; sách in, tài liệu hướng dẫn dạy và học với sự trợ giúp của máy tính; 

bài tập trên Internet và các buổi trao đổi thảo luận, truyền hình hội nghị từ xa; 

bài thực tập ảo, bài thực tập mô phỏng và thực tập thực tế hoặc các học liệu khác 

phù hợp) bảo đảm cung cấp và chuyển tải đầy đủ nội dung, yêu cầu cần đạt của 

chương trình bồi dưỡng để người học có thể tự học, tự bồi dưỡng theo quy định; 

+ Tài liệu bồi dưỡng bán tập trung: Kết hợp tài liệu bồi dưỡng tập trung và 

tài liệu bồi dưỡng từ xa. 

Như vậy, có thể hiểu tài liệu trong bồi dưỡng chuyên môn 1) bao gồm sách 

in, tệp tin văn bản, bài trình chiếu, tệp tin video, tệp tin âm thanh đảm bảo cung 

cấp và chuyển tải đầy đủ nội dung, yêu cầu cần đạt của chương trình bồi dưỡng; 

2) Phải thường xuyên được bổ sung, cập nhật, nâng cao phù hợp với tình hình 

thực tế; 3) bảo đảm kết hợp giữa lí luận và thực tiễn; kiến thức, kinh nghiệm và 

kĩ năng thực hành; 4) phù hợp với yêu cầu và nhu cầu phát triển nguồn nhân lực; 

5) Phù hợp với phương pháp bồi dưỡng tích cực, tăng cường tự học, phát huy 

tính tích cực, chủ động và tư duy sáng tạo của học viên. 

1.1.2. Phát triển tài liệu bồi dưỡng chuyên môn cho GVMN 

Phát triển tài liệu bồi dưỡng GVMN được hiểu là quá trình liên tục 

nghiên cứu, xây dựng tài liệu và điều chỉnh, bổ sung, cập nhật, làm mới toàn 

bộ hoặc một số thành tố của tài liệu bồi dưỡng, để thực hiện mục tiêu bồi dưỡng, 

phát triển năng lực nghề nghiệp cho GVMN phù hợp với yêu cầu đổi mới giáo 

dục mầm non, năng lực của GVMN và điều kiện của địa phương3. 

Trong năm 2021, GVMN cốt cán đã được bồi dưỡng chuyên đề: “Phát triển 

tài liệu bồi dưỡng cho giáo viên đáp ứng yêu cầu đổi mới giáo dục mầm non”, 

qua đó, chúng ta nhận thức được phát triển tài liệu bồi dưỡng cho GVMN là một 

yêu cầu đối với năng lực của GVMN cốt cán để đảm bảo tài liệu phù 



hợp với năng lực của giáo viên và bối cảnh địa phương. Có nhiều loại hình tài 

liệu bồi dưỡng cho GVMN được phát triển, đặc biệt là các dạng tài liệu phù 

hợp với điều kiện công nghệ phát triển, cũng như năng lực ứng dụng CNTT của 

giáo viên như tài liệu dạng in, infographic, video,… Mỗi loại tài liệu có những đặc 

điểm, ưu thế riêng, song khi phát triển tài liệu đều cần đảm bảo tính khoa học, 

chuẩn xác, tính thực tiễn, phù hợp với tính chất, thời lượng của các khóa bồi 

dưỡng và đối tượng người học. Mặt khác, điều kiện mỗi địa phương, vùng miền 

có sự khác nhau về năng lực của giáo viên, các vấn đề cần ưu tiên trong giáo dục 

mầm non, cách thức vận dụng các nội dung, phương pháp giáo dục trẻ, do vậy, 

việc phát triển tài liệu bồi dưỡng cho GVMN cần đáp ứng được sự đa dạng này 

nhằm đảm bảo hiệu quả sử dụng tài liệu. Nội dung tập huấn chuyên đề “phát 

triển tài liệu bồi dưỡng cho giáo viên đáp ứng yêu cầu đổi mới giáo dục mầm 

non” (tài liệu tham khảo số 3, đã dẫn) bao gồm căn cứ phát triển tài liệu bồi dưỡng 

cho giáo viên; đặc điểm học tập của GVMN và việc phát triển tài liệu bồi dưỡng; 

quy trình phát triển tài liệu bồi dưỡng cho giáo viên đáp ứng yêu cầu đổi mới 

giáo dục mầm non, đảm bảo cho GVMN cốt cán vận dụng được các kiến thức, 

kĩ năng đã học để phát triển tài liệu bồi dưỡng GVMN tại địa phương, nhà 

trường. 

Trong chuyên đề này, chúng ta không thảo luận chi tiết đến những vấn đề 

đã đề cập ở trên mà chỉ tập trung tìm hiểu, ứng dụng CNTT trong phát triển tài 

liệu bồi dưỡng chuyên môn cho giáo viên mầm non. 

Ở nước ta, khái niệm CNTT được hiểu là tập hợp các phương pháp khoa học, 

công nghệ và công cụ kĩ thuật hiện đại để sản xuất, truyền đưa, thu thập, xử lí, 

lưu trữ và trao đổi thông tin số. Thông tin số là thông tin được tạo lập bằng 

phương pháp dùng tín hiệu số4. Ứng dụng CNTT trong hoạt động bồi dưỡng 

chuyên môn cho GVMN là việc sử dụng các thiết bị CNTT, phần mềm, học liệu 

điện tử và mạng viễn thông (chủ yếu là mạng Internet) hỗ trợ các hoạt động bồi 

dưỡng chuyên môn nhằm đổi mới nội dung, phương pháp và hình thức tổ chức 

tập huấn bồi dưỡng, nâng cao hiệu quả công tác bồi dưỡng GVMN. 



Các Thông tư số 19/2019/TT-BGDĐT và số 17/2022/TT-BGDĐT, của Bộ 

Giáo dục và Đào tạo, đã quy định các tiêu chuẩn của báo cáo viên trong hoạt động 

bồi dưỡng. Một trong những yêu cầu đối với báo cáo viên là: “Có kĩ năng ứng 

dụng công nghệ thông tin trong thiết kế, xây dựng và phát triển tài liệu, học liệu 

để bồi dưỡng giáo viên, cán bộ quản lí”. 

Như vậy, GVMN cốt cán cần có kĩ năng ứng dụng CNTT để phát triển tài 

liệu bồi dưỡng chuyên môn cho GVMN. Chuyên đề này định hướng đến mục tiêu 

nâng cao năng lực ứng dụng CNTT cho GVMN cốt cán trong phát triển tài liệu 

bồi dưỡng chuyên môn cho GVMN, cụ thể là khai thác các phần mềm để: 

- Cập nhật, bổ sung nội dung cho tài liệu đảm bảo chuyển tải trung thực 

nội dung tập huấn và cập nhật, bổ sung các nội dung khác để đảm bảo tính 

lí luận, khoa học, phù hợp với thực tiễn; 

- Biên tập tài liệu dưới các định dạng khác nhau như bài trình chiếu, tệp 

âm thanh, hình ảnh để sử dụng trong quá trình bồi dưỡng, phù hợp với 

hình thức bồi dưỡng, kịch bản bồi dưỡng, phương pháp bồi dưỡng. 

1.1.1. Hoạt động 2: Tìm hiểu vai trò của CNTT trong phát triển tài liệu bồi 

dưỡng chuyên môn cho GVMN 

1.2. Vai trò của CNTT trong phát triển tài liệu bồi dưỡng chuyên môn cho 

GVMN 

1.2.1. Vai trò của CNTT trong bồi dưỡng chuyên môn cho GVMN 

Với sự có mặt của CNTT trong hầu hết hoạt động của đời sống xã hội, thể 

hiện qua thiết bị nghe nhìn, điện thoại thông minh, mạng Internet, các phần mềm 

ứng dụng,… CNTT ngày càng có nhiều tác động, ảnh hưởng sâu rộng và có vai 

trò quan trọng trong đời sống xã hội nói chung, trong giáo dục nói riêng. Trong 

những năm qua, ứng dụng CNTT đã mang lại những chuyển biến mới mẻ và hiệu 

quả tích cực đối với hoạt động bồi dưỡng chuyên môn cho GVMN. Để có cách 

nhìn chi tiết và đánh giá vai trò của CNTT trong hoạt động bồi dưỡng chuyên môn 

cho GVMN, chúng ta cùng xem xét các hoạt động chủ yếu trong quá trình bồi 



dưỡng và sự hỗ trợ của CNTT trong hình 1.2.1. 
 

Hình 1.2.1: Ứng dụng CNTT trong bồi dưỡng chuyên môn cho GVMN. 

1.2.1.1. Trước bồi dưỡng 

Đây là giai đoạn xây dựng kế hoạch cho hoạt động bồi dưỡng chuyên môn. 

Đơn vị hoặc cá nhân, tổ chức cần có những thông tin liên quan đến hoạt động 

bồi dưỡng, gồm 1) những thông tin cơ bản như số lượng học viên theo từng đơn 

vị, độ tuổi, giới tính, trình độ học vấn, những nội dung đã được bồi dưỡng,… và 

2) những thông tin liên quan trực tiếp đến đợt bồi dưỡng như nguyện vọng của 

học viên về hình thức, nội dung, phương pháp tập huấn,... Những thông tin này 

mang tính cá nhân của học viên, người tổ chức cần phải khảo sát, điều tra để có 

được một bồi dưỡng thành công, hiệu quả. 

Trên cơ sở các thông tin thu thập được, người tổ chức sẽ lập kế hoạch, chuẩn 

bị tài liệu phù hợp với nội dung, phương pháp, hình thức dự định triển khai tập 

huấn; gửi thông báo cho các đơn vị, cho học viên để phối hợp triển khai,... Với 

những hoạt động này, nếu không có CNTT thì việc triển khai sẽ tốn nhiều thời 

gian và khó đạt hiệu quả cao. 

Ví dụ: Sử dụng bảng điều tra qua các ứng dụng Google Forms, Microsoft 



Forms sẽ hiệu quả hơn rất nhiều cách điều tra và tổng hợp bằng văn bản. Sử dụng 

các phần mềm soạn thảo văn bản, phần mềm biên tập hình ảnh, video để biên 

tập tài liệu bồi dưỡng chuyên môn sẽ đáp ứng được phù hợp giữa tài liệu với 

hình thức bồi dưỡng. Chúng ta không thể sử dụng các cách biên tập tài liệu bồi 

dưỡng truyền thống trong bồi dưỡng bằng hình thức trực tuyến hoặc kết hợp. 

1.2.1.2. Trong bồi dưỡng 

Đây là quá trình diễn ra sự tương tác giữa báo cáo viên và học viên nhằm 

triển khai các nội dung bồi dưỡng: Mong muốn của người tổ chức và báo cáo viên 

là: 1) truyền đạt những nội dung trong tài liệu bồi dưỡng và những nội dung liên 

quan theo chủ đề đến với học viên; 2) thông qua các hoạt động để hình thành, 

xây dựng, phát triển những phẩm chất, năng lực cho học viên, qua đó nâng cao 

năng lực, phẩm chất toàn diện cho học viên để phục vụ tốt hơn công tác chăm 

sóc, nuôi dạy trẻ. Hoạt động tập huấn có thể diễn ra trực tiếp, thông qua một 

công cụ hội thảo video trực tuyến hoặc kết hợp; không hoặc kết hợp với hệ thống 

quản lí học tập (LMS) để tăng cường hoạt động cho học viên. 

Ví dụ: Trong bồi dưỡng từ xa, báo cáo viên và học viên tương tác với nhau 

qua công cụ hội thảo video trực tuyến (chẳng hạn Google Meet), báo cáo viên 

muốn triển khai hoạt động nhóm. Báo cáo viên có thể chia lớp thành các nhóm 

theo đúng kịch bản sư phạm của mình, quy định chi tiết thời gian hoạt động, cách 

thức hoạt động, nội dung hoạt động, sản phẩm,… Tiếp theo, các nhóm có thể 

tương tác với nhau qua các công cụ hội thảo video trực tuyến để thảo luận, hoạt 

động và cho ra sản phẩm của hoạt động nhóm. Lúc này, báo cáo viên cũng có 

thể quan sát các nhóm hoạt động, hoặc tham gia vào hoạt động của các nhóm 

với vai trò định hướng, hỗ trợ nếu cần thiết. Tiếp theo, sản phẩm của các nhóm 

sẽ được “trưng bày” để các nhóm khác có thể tham khảo, góp ý thảo luận. Tại 

bước này, phần mềm Padlet sẽ đáp ứng được. Chẳng hạn báo cáo viên tạo trước 

Padlet, gửi đường dẫn (link) và quy định các nhóm nộp sản phẩm vào các vị trí 

tương ứng. 

Như vậy, với hệ thống LMS cùng với các thiết bị, hệ thống hỗ trợ (như máy 



tính, điện thoại thông minh, mạng viễn thông, hệ thống tài liệu,...), hình thức tập 

huấn đã được đa dạng hóa, phù hợp hơn với tình hình thực tiễn. Điều này cho 

phép người tổ chức lựa chọn, xây dựng được phương án tập huấn, bồi dưỡng tối 

ưu hơn; cho phép báo cáo viên xây dựng kịch bản tập huấn, bồi dưỡng đa dạng 

và hiệu quả hơn; cho phép học viên tham gia bồi dưỡng thuận lợi hơn, với chi 

phí nhỏ hơn. 

1.2.1.3. Sau bồi dưỡng 

Đây là giai đoạn học viên hoàn thiện các sản phẩm bồi dưỡng, để một phần 

thể hiện mức độ hoàn thành các nội dung bồi dưỡng; người tổ chức và báo cáo 

viên đánh giá học viên, cùng với quá trình đánh giá thường xuyên để có đánh 

giá chính xác về các học viên. Cùng với những thông tin thu thập được trong quá 

trình bồi dưỡng và sau khi bồi dưỡng trực tiếp, người tổ chức sẽ có nhìn nhận 

tổng thể, chi tiết về tất cả các khâu của quá trình bồi dưỡng: Lập kế hoạch, triển 

khai, báo cáo viên, tài liệu, chi phí,... Với ứng dụng CNTT, các hoạt động này sẽ 

được triển khai có hiệu quả. 

Ví dụ: Sau hoạt động bồi dưỡng tập trung, học viên cần một thời gian để 

hoàn thành các sản phẩm học tập, kiểm tra đánh giá và “nộp” sản phẩm của mình. 

Nếu theo cách truyền thống, chẳng hạn học viên viết báo cáo trên giấy, gửi đến 

một địa điểm; tiếp theo đơn vị tổ chức tập hợp các sản phẩm để gửi cho đơn vị 

hoặc cá nhân xem xét, đánh giá,... thì quá trình này phải tiến hành trong thời gian 

dài và gây phiền hà cho học viên, báo cáo viên và đơn vị tổ chức. Thay vào đó, 

nếu ứng dụng CNTT, chúng ta sẽ triển khai các hình thức làm bài tập trực tuyến, 

nộp bài trực tuyến,... qua email, qua các công cụ kiểm tra đánh giá, hoặc qua hệ 

thống LMS thì những hoạt động này sẽ đơn giản và thuận tiện hơn rất nhiều. 

Như vậy, chúng ta có thể thấy được vai trò của CNTT trong tổ chức bồi 

dưỡng chuyên môn là: 

- Hỗ trợ thu thập thông tin, xử lí thông tin nhanh, chính xác với chi 

phí thấp hơn; 

- Đa dạng hóa hình thức bồi dưỡng; 



- Tạo điều kiện, hỗ trợ học viên đa dạng hóa hình thức học tập và hoàn thành 

nội dung bồi dưỡng, linh hoạt tùy theo điều kiện thực tế; 

- Hỗ trợ báo cáo viên triển khai các phương pháp bồi dưỡng tích cực, theo 

đúng kịch bản sư phạm để định hướng đến mục tiêu đã đặt ra; 

- Tạo điều kiện cho học viên tự học, tự bổ sung và phát triển phẩm chất 

năng lực, đáp ứng nhu cầu công việc. 

1.2.2. Vai trò của công nghệ thông tin trong phát triển tài liệu bồi dưỡng chuyên 

môn cho GVMN 

Sau khi tiếp nhận tài liệu bồi dưỡng một chuyên đề nào đó, cùng với tất cả 

các thông tin liên quan về hoạt động bồi dưỡng (kế hoạch, hình thức bồi dưỡng, 

thông tin học viên, điều kiện cơ sở vật chất,…), báo cáo viên (trong trường hợp 

cụ thể này là GVMN cốt cán đã có thời gian bồi dưỡng về nội dung này) sẽ phải: 

- Nghiên cứu nội dung của tài liệu kĩ lưỡng, cẩn thận; 

- Căn cứ vào điều kiện thực tế ở địa phương, năng lực, phẩm chất của học 

viên mình chuẩn bị bồi dưỡng để quyết định, xây dựng kịch bản, phương 

pháp bồi dưỡng phù hợp; 

- Phát triển tài liệu cho bồi dưỡng chuyên môn phù hợp với kịch bản sư 

phạm và phương pháp bồi dưỡng: Đây là hoạt động quan trọng của báo 

cáo viên, có ý nghĩa quyết định đến hiệu quả của hoạt động bồi dưỡng. 

Cần chú ý: Đối với một số hình thức bồi dưỡng, ví dụ bồi dưỡng qua hệ 

thống LMS, học viên sẽ có thời gian làm việc, nghiên cứu tài liệu, hoạt động theo 

kịch bản của hệ thống LMS; tuy vậy, báo cáo viên vẫn sẽ phải chuẩn bị kịch bản, 

phương pháp, tài liệu cho thời gian báo cáo trực tiếp với học viên (tập trung hoặc 

qua mạng). Việc phát triển tài liệu bồi dưỡng là cần thiết và quan trọng trong tất 

cả các hình thức bồi dưỡng. 

Như đã trình bày trong mục 1.1.2, chuyên đề này định hướng đến mục tiêu 

nâng cao năng lực ứng dụng CNTT cho GVMN cốt cán trong phát triển tài liệu, 

cụ thể trên các công việc: 1) Cập nhật, bổ sung nội dung cho tài liệu đảm bảo 



chuyển tải trung thực nội dung tập huấn và cập nhật, bổ sung các nội dung khác 

để đảm bảo tính lí luận, khoa học, phù hợp với thực tiễn; 2) Biên tập tài liệu dưới 

dạng các định dạng khác nhau như bài trình chiếu, tệp âm thanh, hình ảnh để sử 

dụng trong quá trình bồi dưỡng, phù hợp với hình thức bồi dưỡng, kịch bản 

bồi dưỡng, phương pháp bồi dưỡng. 

Chúng ta cùng xem xét một số ví dụ thường gặp sau. 

GVMN cốt cán xây dựng bài báo cáo chuyên đề bằng phần mềm MS 

PowerPoint hoặc Google Slides để trình bày một nội dung của tài liệu (có 

thể xem thêm tài liệu bồi dưỡng mô đun: “Kĩ năng báo cáo chuyên đề bồi dưỡng 

giáo viên mầm non”5). Lúc đó người biên tập tài liệu cần phải xây dựng kịch 

bản và chi tiết các nội dung của từng trang trình chiếu (slide); cấu trúc lại nội 

dung cần trình bày một cách ngắn gọn, dễ hiểu; khai thác hình ảnh, sơ đồ để biểu 

diễn trực quan vấn đề cần trình bày; các vấn đề về kĩ thuật như kích thước màn 

chiếu, màu sắc, kích cỡ đối tượng (chữ, bảng biểu, sơ đồ,… trong trang trình 

chiếu), các hiệu ứng âm thanh, hình ảnh,… Một bài thuyết trình hay, ngoài kĩ 

năng của báo cáo viên thì bài trình chiếu có ảnh hưởng không nhỏ đến việc thu 

hút người nghe, kích thích người nghe tập trung vào những vấn đề mà báo cáo 

viên muốn chuyển tải, trao đổi, thảo luận,… theo kịch bản đã xây dựng. 

GVMN cốt cán sơ đồ hóa các nội dung của một phần tài liệu bằng các 

sơ đồ tư duy, biểu đồ,… Việc sơ đồ hóa bằng các sơ đồ tư duy giúp học viên 

có cách nhìn toàn diện đối với nội dung thể hiện, qua đó học viên có thể nhanh 

chóng nắm bắt những nội dung cốt lõi, làm cơ sở để triển khai các hoạt động bồi 

dưỡng khác một cách hiệu quả. Việc sơ đồ hóa này có thể được thực hiện thuận 

lợi hơn (xây dựng và biên tập nhanh hơn, thay đổi, bổ sung các đối tượng của sơ 

đồ nhanh hơn,…) với các phần mềm vẽ sơ đồ tư duy như MindMaple Classic, 

iMindMap,… 

GVMN cốt cán xây dựng video cho bồi dưỡng chuyên môn: Video có thể 

sử dụng cho nhiều mục đích khác nhau, như cho báo cáo chuyên đề (xem thêm 



tài liệu tham khảo 5, đã dẫn); minh họa một tình huống giả định hoặc có thật; 

thể hiện nhanh một quy trình, một phương pháp, một hoạt động mẫu,… Tùy theo 

mục đích, nội dung, kịch bản của video hướng đến, chúng ta có thể thu thập 

nguyên liệu cho video là các hình ảnh, đoạn video khai thác từ Internet hoặc tự 

quay bằng camera, điện thoại di động và tiến hành biên tập bằng các phần mềm 

thông dụng như CapCut, Camtasia,… 

GVMN cốt cán xây dựng trò chơi học tập: Trò chơi học tập có thể được 

sử dụng cho nhiều mục đích khác nhau như tổ chức hoạt động khởi động, để tìm 

hiểu kiến thức, quan điểm của học viên về một phần nội dung nào đó, để tổng 

kết, đánh giá một hoạt động bồi dưỡng,… Tùy theo mục đích, kịch bản, nội 

dung trò chơi hướng đến mà chúng ta thiết kế luật chơi, hệ thống câu hỏi. Trong 

khi tiến hành trò chơi có thể kết hợp với giải thích, thảo luận để làm sáng tỏ một 

nội dung hoặc những lựa chọn được xem là “đáp án”. Để tiến hành những trò 

chơi học tập như thế này, GVMN cốt cán cần trang bị những kĩ năng cần thiết 

về CNTT và sử dụng các phần mềm tổ chức trò chơi thông dụng như Kahoot, 

Quizizz,… 

Qua những ví dụ ở trên và thực tiễn ứng dụng CNTT trong các hoạt động 

bồi dưỡng chuyên môn, vai trò của CNTT thể hiện ở những điểm sau: 

- Là công cụ, phương tiện để phát triển tài liệu phù hợp với mục tiêu, nội 

dung, phương pháp, kiểm tra đánh giá,… trong bồi dưỡng với chi phí thấp và thời 

gian ngắn. 

+ Đối với việc cập nhật, bổ sung nội dung cho tài liệu: CNTT hỗ trợ cung 

cấp nguồn thông tin nhanh qua các phần mềm tìm kiếm, hệ thống tài liệu có độ 

tin cậy cao, ví dụ các trang thông tin điện tử của Chính phủ, Bộ Giáo dục và Đào 

tạo, sách, bài báo khoa học,… 

+ Đối với việc biên tập tài liệu: CNTT hỗ trợ biên tập tài liệu nhanh với 

chi phí thấp. Mặt khác, CNTT hỗ trợ biên tập tài liệu dưới nhiều định dạng khác 

nhau. Với các phần mềm từ đơn giản, thông dụng đến phần mềm chuyên nghiệp, 

tùy theo năng lực CNTT, người biên tập tài liệu có thể lựa chọn được những 



phần mềm phù hợp để sử dụng… 

- Tạo điều kiện, kích thích, hỗ trợ báo cáo viên tổ chức triển khai các hoạt 

động bồi dưỡng đa dạng, hiệu quả. 

Các hoạt động bồi dưỡng được tổ chức trong một kịch bản khoa học, đảm 

bảo tính sư phạm và định hướng đạt được các mục tiêu bồi dưỡng. Để nâng cao 

hiệu quả bồi dưỡng, báo cáo viên cần thay đổi các hoạt động bồi dưỡng, sao cho 

kích thích được đam mê học tập của các học viên. Trong quá trình thiết kế tổ chức 

hoạt động, một vấn đề quan trọng là tài liệu, cách thức tương tác giữa báo cáo 

viên và học viên. 

- Tạo điều kiện cho học viên tự học, tự bổ sung và phát triển phẩm chất năng 

lực, đáp ứng nhu cầu công việc. Với loại hình tài liệu đa dạng và đảm bảo tính 

cập nhật, khoa học, dễ dàng trong việc sử dụng, CNTT có vai trò quan trọng cho 

học viên thực hiện việc tự học, tự bổ sung và phát triển phẩm chất, năng lực linh 

hoạt, phù hợp với điều kiện cụ thể. Chẳng hạn, chỉ với điện thoại di động thông 

minh, học viên có thể truy cập vào hệ thống LMS để nghiên cứu tài liệu, làm 

bài tập, tương tác với báo cáo viên hoặc học viên khác, tìm kiếm và xem nguồn 

tài liệu mở rộng,… mọi lúc, mọi nơi. 

1.3. Một số gợi ý trong việc lựa chọn phần mềm hỗ trợ khai thác, biên tập 

tài liệu bồi dưỡng chuyên môn cho GVMN 

Việc ứng dụng CNTT vào các hoạt động của đời sống nói chung, trong hoạt 

động khai thác, biên tập tài liệu bồi dưỡng chuyên môn cho GVMN nói riêng là 

cần thiết và quan trọng. Vấn đề đặt ra là GVMN cốt cán nên lựa chọn sử dụng 

những phần mềm nào để phát triển tài liệu bồi dưỡng nói riêng, phục vụ hoạt động 

chuyên môn nói chung? Việc lựa chọn sử dụng phần mềm phụ thuộc vào nhiều 

yếu tố như: Nhu cầu của công việc (hay mục đích sử dụng phần mềm); những 

đặc trưng, tính năng của phần mềm; sự thông dụng của phần mềm; thói quen 

của người dùng; kĩ năng CNTT; điều kiện kinh tế, những người hỗ trợ về 

CNTT;… Thực tế cho thấy, có những phần mềm thông dụng, được nhiều người 

lựa chọn vì có những tính năng đáp ứng nhu cầu của đa số người dùng mặc dù 



những phần mềm này không miễn phí và người dùng phải mất nhiều thời gian, 

chi phí để nâng cao kĩ năng sử dụng. Chẳng hạn các phần mềm của bộ MS Office, 

như MS Word. MS Word đáp ứng hầu hết các yêu cầu về chế bản văn bản thông 

dụng như thông báo, công văn, sách, tài liệu, bài báo khoa học,… 

Tuy nhiên, hiện nay có nhiều phần mềm có chức năng tương đồng, có thể 

thay thế lẫn nhau nên để việc ứng dụng CNTT mang lại hiệu quả thiết thực cho 

công việc mà không gây tốn kém về chi phí hoặc thời gian, việc lựa chọn sử dụng 

phần mềm cần căn cứ vào những yếu tố như sau: 

Thứ nhất là nhu cầu của công việc nói chung và nhu cầu phát triển tài 

liệu nói riêng. Thông thường, máy tính thường được cài đặt hệ điều hành, đi kèm 

theo một số phần mềm nhỏ, hoặc tiện ích, có thể hỗ trợ công việc ở mức độ đơn 

giản. Ví dụ các hệ điều hành thông dụng, như hệ điều hành Windows 10, có các 

tiện ích chỉnh sửa hình ảnh, chỉnh sửa video, thu âm,... ở mức độ cơ bản. Chúng 

ta cũng thường cài đặt các ứng dụng phổ biến, như bộ MS Office (thông thường 

bao gồm MS Excel để lập bảng tính, MS PowerPoint để tạo bài trình chiếu, MS 

Word để soạn thảo văn bản,...); trình duyệt web để truy cập web hoặc tìm kiếm 

thông tin (như Firefox, Google Chrome, Cốc Cốc,...); phần mềm đọc tệp tin pdf 

(như Adobe Reader, Foxit Reader,...);… 

Nếu nhu cầu của chúng ta cao hơn, chúng ra sẽ nghĩ đến việc lựa chọn và 

cài đặt các phần mềm khác. Ví dụ chúng ta muốn xây dựng tài liệu bồi dưỡng 

dạng video, chúng ta cần phải sử dụng được và cài đặt vào máy tính một phần 

mềm chỉnh sửa video; đi kèm là các phần mềm chỉnh sửa hình ảnh, hoặc thu âm 

và chỉnh sửa tệp âm thanh. Tùy theo yêu cầu của video cần xây dựng, ví dụ chất 

lượng hình ảnh, các hiệu ứng video,… mà chúng ta có thể lựa chọn phần mềm 

phù hợp. 

Như vậy, việc lựa chọn, sử dụng phần mềm nhằm đảm bảo các yêu cầu trong 

việc phát triển tài liệu bồi dưỡng chuyên môn. 

Thứ hai là tính thông dụng của phần mềm. Sử dụng một phần mềm thông 

dụng, chúng ta sẽ 1) kế thừa được những sản phẩm của những người khác mà 



chúng ta tham khảo; 2) phối hợp hoạt động phát triển tài liệu với nhiều người; 

thuận tiện trong việc chia sẻ, in ấn, sử dụng tài liệu. Ví dụ qua một đợt bồi dưỡng, 

GVMN cốt cán thường được các báo cáo viên chia sẻ các tài liệu bồi dưỡng, chẳng 

hạn bài trình chiếu, thông thường được thiết kế trên phần mềm MS PowerPoint. 

Nếu GVMN cốt cán cũng thành thạo trong việc sử dụng phần mềm MS 

PowerPoint hoặc những phần mềm có thể đọc và chỉnh sửa được tệp tin dạng 

*.pptx thì việc biên tập và chỉnh sửa bài trình chiếu sẽ tốn ít thời gian hơn rất 

nhiều so với việc sử dụng một phần mềm khác và làm lại từ đầu. 

Thứ ba thuận tiện trong việc sử dụng và thao tác đơn giản. Hiện nay, 

thói quen sử dụng phần mềm của người dùng dần thay đổi, khi điện thoại di 

động thông minh và các thiết bị di động cầm tay đang có những ứng dụng mà 

dưới một góc độ nhìn nhận nào đó là có thể thay thế cho các phần mềm trên máy 

tính. Chẳng hạn chúng ta thường sử dụng điện thoại di động thông minh để chụp 

ảnh và sử dụng những ứng dụng để chỉnh sửa ảnh thay vì sử dụng máy tính. Vì 

vậy, nếu có phần mềm trên điện thoại thông minh hoặc làm việc trực tuyến thì sẽ 

tạo ra lợi thế trong việc sử dụng, vì chúng ta có thể làm việc mọi lúc, mọi nơi. 

Thật khó để đòi hỏi những phần mềm vừa có thao tác đơn giản, vừa đáp ứng 

nhu cầu hoặc mục đích sử dụng, tuy nhiên, một số trường hợp là có thể. Ví dụ 

chúng ta muốn thu một đoạn lời thoại hoặc âm thanh nói chung hoặc là một thao 

tác đơn giản đối với ảnh, video (cắt tệp tin video chẳng hạn), lúc đó các phần mềm 

thao tác đơn giản sẽ là lựa chọn tốt. Một thực tế là các phần mềm đều hướng 

đến việc sử dụng của người dùng nên nhìn chung GVMN cốt cán sẽ không gặp 

nhiều khó khăn khi sử dụng ở mức độ cơ bản, đối với các phần mềm thông dụng. 

Thứ tư là phù hợp với phần cứng và hệ điều hành. Mỗi một phần mềm 

đều có yêu cầu đối với hệ điều hành và phần cứng. Do đó, chúng ta nên chọn 

những phần mềm phù hợp với máy tính chúng ta đang sử dụng. 

Thứ năm là chi phí để sử dụng phần mềm. Để sử dụng phần mềm, người 

dùng có thể dùng bản miễn phí, bản dùng thử (có giới hạn ngày và tính năng), 

bản trả phí theo thời hạn hoặc trả phí sử dụng vĩnh viễn, tùy theo phần mềm. Các 



phần mềm cho giáo dục thường có bản miễn phí hoặc dùng thử. Hơn nữa, hoạt 

động phát triển tài liệu không phải là thường xuyên, có tính chuyên nghiệp mà 

thông thường tập trung làm trong một khoảng thời gian, vì vậy có thể sử dụng 

bản miễn phí hoặc dùng thử. 

Với định hướng khai thác những phần mềm đáp ứng nhu cầu phát triển tài 

liệu bồi dưỡng chuyên môn cho GVMN, không quá phức tạp trong cài đặt, sử 

dụng. Nhóm tác giả sẽ giới thiệu những phần mềm có thể sử dụng phiên bản miễn 

phí hoặc dùng thử, đơn giản trong sử dụng, không yêu cầu quá cao về phần cứng 

hoặc có thể sử dụng trực tuyến. 

NỘI DUNG 2: Khai thác tài liệu từ Internet phục vụ phát triển tài liệu bồi 

dưỡng chuyên môn cho GVMN 

2.1. Một số lưu ý trong tìm kiếm, khai thác, sử dụng tài liệu từ Internet 

2.1.1. Những vấn đề chung về tìm kiếm, khai thác, sử dụng tài liệu từ Internet 

Khi có nhu cầu về thông tin, tài liệu nói chung và thông tin, tài liệu cho phát 

triển tài liệu trong bồi dưỡng chuyên môn cho GVMN nói riêng, chúng ta thường 

tìm kiếm và khai thác nguồn tài liệu từ Internet. Việc tìm kiếm và khai thác có 

thể thực hiện qua: 

- Các phần mềm tìm kiếm: Các phần mềm tìm kiếm, như Google (https:// 

www.google.com/), Bing (https://www.bing.com/),... có ưu điểm là dễ sử dụng 

và cho kết quả nhanh; tuy nhiên, kết quả tìm kiếm thường rất rộng (kết quả tìm 

kiếm bao gồm nhiều trang, nhiều lựa chọn nếu chúng ta không sử dụng các kĩ 

thuật tìm kiếm hợp lí), gây khó khăn cho việc khai thác sử dụng; việc sử dụng 

các kĩ thuật để cho kết quả mong muốn sẽ đề cập đến trong phần tiếp theo của 

tài liệu; 

- Các trang web có các nội dung theo chủ đề, ví dụ trang web cung cấp 

thư viện giáo án điện tử, trang web cung cấp nguồn tài liệu học thuật, trang web 

cung cấp nguồn ảnh miễn phí, video miễn phí,… 

http://www.google.com/)
http://www.bing.com/)%2C


Thông thường, việc tìm kiếm có thể diễn ra trong 5 bước như hình 2.1.1. 

 

Hình 2.1.1: Các bước của quá trình tìm kiếm, khai thác thông tin từ Internet. 

Bước 1: Xác định yêu cầu của tài liệu căn cứ vào mục tiêu của tài liệu 

tìm kiếm, hoặc mục tiêu gắn với việc sử dụng tài liệu; 

Bước 2: Xác định các từ khóa sử dụng để tìm kiếm. Các từ khóa là những 

từ, cụm từ chứa đựng những đặc trưng của tài liệu cần tìm kiếm; 

Bước 3: Lựa chọn trang web hoặc phần mềm tìm kiếm. Ví dụ để tìm kiếm 

tài liệu học thuật, chúng ta thường vào trang https://scholar.google.com/; để tìm 

kiếm ảnh hoặc video, chúng ta có thể vào các trang cung cấp ảnh và video miễn 

phí như https://www.pexels.com/vi-vn/ hoặc là tìm kiếm từ Google. 

Bước 4: Thực hiện tìm kiếm bằng các thao tác (xem thêm phần 2.2) trên 

trang tìm kiếm. 

Bước 5: Đánh giá kết quả tìm kiếm được. Tùy theo yêu cầu tìm kiếm, kết 

quả tìm kiếm thường gồm một số tài liệu từ các nguồn khác nhau. Chúng ta cần 

phải đánh giá xem 1) tài liệu có phù hợp với yêu cầu hay không? 2) có tài liệu nào 

phù hợp hơn, chất lượng tốt hơn không? 3) việc sử dụng tài liệu này vào bồi dưỡng 

chuyên môn cho GVMN có phù hợp không?... Việc đánh giá kết quả tìm kiếm 

đòi hỏi chúng ta phải có những kĩ năng về đánh giá, nhận diện thông tin, kiểm 

chứng thông tin. 

Nếu kết quả tìm kiếm chưa phù hợp, chúng ta cần quay lại các bước trước 

và tiếp tục thực hiện việc tìm kiếm. Ví dụ quay lại bước 3: Bức ảnh chúng ta cần 

tìm không có (hoặc không đạt yêu cầu) ở trang web ảnh miễn phí này, chúng ta 

có thể thay bằng trang web ảnh miễn phí khác. 

https://scholar.google.com/
https://www.pexels.com/vi-vn/


2.1.2. Một số lưu ý trong khai thác, sử dụng tài liệu từ Internet 

Trong quá trình tìm kiếm, khai thác tài liệu Internet, người dùng nói chung 

và GVMN cốt cán nói riêng cần tuân thủ các qui định của Pháp luật có liên quan 

như Bộ luật Dân sự, Luật Sở hữu trí tuệ, Luật An ninh mạng,… Tuy nhiên, không 

phải lúc nào chúng ta cũng cần “soi chiếu” vào các qui định, để xem xét có hợp 

lí trong khai thác, sử dụng hay không. Vì vậy, khi khai thác, sử dụng tài liệu từ 

Internet vào hoạt động bồi dưỡng chuyên môn, GVMN cốt cán cần lưu ý: 

- Phù hợp với quan điểm, đường lối của Đảng Cộng sản Việt Nam; tuân 

thủ Hiến pháp và pháp luật Việt Nam; 

- Nội dung, hình thức của tài liệu phù hợp với văn hóa, lịch sử, địa lí, đạo 

lí, thuần phong mỹ tục của Việt Nam; đảm bảo tính khoa học, sư phạm, 

thẩm mỹ, gắn với điều kiện thực hiện chương trình giáo dục mầm non 

tại các địa phương; đảm bảo quyền trẻ em; 

- Phù hợp với mục tiêu, nội dung, phương pháp, hình thức tổ chức các hoạt 

động trong bồi dưỡng chuyên môn; 

- Các thuật ngữ, các khái niệm, định nghĩa, sự kiện, hình ảnh bảo đảm tính 

chính xác, khách quan, nhất quán; các hình ảnh, sự kiện, số liệu có nguồn 

gốc rõ ràng; 

- Trích dẫn rõ ràng chi tiết nguồn tài liệu. 

Cần lưu ý thêm về trích dẫn tài liệu. Trong nhiều trường hợp như sử dụng 

thông tin từ một trang web, từ một quyển sách, bài báo khoa học,… chúng ta cần 

trích dẫn nguồn gốc của tài liệu. Việc trích dẫn tài liệu là cần thiết, để đảm bảo 

vấn đề quyền tác giả, liêm chính khoa học,… và những ý nghĩa khác, như: 

+ Tạo niềm tin cho người đọc, vì việc trích dẫn đã chứng minh thông tin 

cung cấp là thông tin có giá trị khoa học, chính xác; 

+ Người đọc (hoặc học viên) quan tâm đến vấn đề đó (trong tài liệu trích 

dẫn) thì có thể tìm hiểu thêm trong tài liệu gốc để có nhiều thông tin hơn. 

2.2. Một số phần mềm tìm kiếm, khai thác tài liệu từ Internet 

https://thuvienphapluat.vn/van-ban/Bo-may-hanh-chinh/Hien-phap-nam-2013-215627.aspx


2.2.1. Một số phần mềm tìm kiếm tài liệu từ Internet 

Các phần mềm tìm kiếm thường có các chức năng: 

- Cung cấp các kết quả tìm kiếm liên quan; 

- Giao diện dễ hiểu, dễ đọc; 

- Có các tùy chọn mở rộng hoặc thu hẹp kết quả tìm kiếm. 

Với các tiêu chí này, danh sách các phần mềm tìm kiếm dưới đây đáp ứng 

được nhu cầu tìm kiếm. 

2.2.1.1. Phần mềm tìm kiếm Google (https://www.google.com/) 

 

Hình 2.2.1: Minh họa phần mềm tìm kiếm Google. 

Google là phần mềm tìm kiếm được sử dụng nhiều trên thế giới. Google 

cho kết quả nhanh chóng, đưa ra các mục liên quan và có các công cụ hỗ trợ 

như tìm kiếm theo thời gian, ngôn ngữ,… Ngoài ra nó còn cung cấp tìm kiếm 

theo hình 

ảnh, tin tức, video và bản đồ, đây là các dịch vụ nổi bật để tìm kiếm hình ảnh, chỉ 

đường và đọc tin tức. 

Các ưu điểm của phần mềm tìm kiếm Google là: 

http://www.google.com/)
https://quantrimang.com/cong-nghe/google-la-gi-163417


- Cung cấp kết quả tìm kiếm chất lượng trong giao diện dễ sử dụng; 

- Cập nhật kết quả và tính năng thường xuyên; 

- Có danh mục các trang web lớn. 

2.2.1.2. Phần mềm tìm kiếm Bing (https://www.bing.com/) 

Bing cũng là phần mềm tìm kiếm thông dụng. Tương tự Google, Bing hỗ trợ 

tìm kiếm thông qua các từ khóa và các lựa chọn như ảnh, video, bản đồ,… 
 

Hình 2.2.2: Minh họa phần mềm tìm kiếm Bing. 

Ưu điểm của phần mềm tìm kiếm Bing là có tính năng lập chỉ mục video nổi 

bật và đang được đầu tư phát triển tích hợp trí tuệ nhân tạo. 

2.2.1.3. Phần mềm tìm kiếm DuckDuckGo (https://duckduckgo.com/) 

 

Hình 2.2.3: Minh họa phần mềm tìm kiếm DuckDuckGo. 

DuckDuckGo có một số tính năng như hiển thị tất cả thông tin cần tìm trên 

https://www.bing.com/
https://duckduckgo.com/


trang kết quả đầu tiên (Google và Bing liệt kê tất cả các trang kết quả), cung cấp 

lời nhắc (giúp làm rõ câu hỏi tìm kiếm). Ngoài ra, phần mềm tìm kiếm này ít chứa 

quảng cáo. 

Các ưu điểm của phần mềm tìm kiếm DuckDuckGo là: 

- Cho kết quả nhanh; 

- Giao diện gọn gàng và đơn giản. 

2.2.2. Một số nguồn tài liệu 

Phần này liệt kê một số trang web mà GVMN có thể truy cập để khai thác 

được tài liệu cho bồi dưỡng chuyên môn. Để tìm kiếm, khai thác, sử dụng những 

tài liệu trên các trang này, chúng ta thường phải đăng kí. Việc tìm kiếm tài liệu 

trên các trang này là đơn giản hơn so với việc tìm kiếm từ Google hoặc các phần 

mềm tìm kiếm khác. 
 

Tên trang web hoặc địa chỉ Tính năng cơ bản 

https://scholar.google.com/ Nguồn tài liệu học thuật 

https://igiaoduc.vn 

https://www.twinkl.com.vn 

http://giaoduc.itrithuc.vn/ 

https://thuvien.edu.vn/feature/khohoclieudientu,... 

Kho học liệu số, được 

phân loại theo chủ đề, 

theo độ tuổi 

https://giaoan.violet.vn/ Thư viện giáo án điện tử 

https://vi.cleanpng.com/ 

https://unsplash.com/ 

https://pixabay.com/ 

https://www.pexels.com/ 

Ảnh, video miễn phí 

https://www.twinkl.com.vn/
http://giaoduc.itrithuc.vn/
https://thuvien.edu.vn/feature/khohoclieudientu
https://giaoan.violet.vn/
https://pixabay.com/
http://www.pexels.com/


https://www.education.com/ Các trò chơi, hoạt động, 

giáo án, video, bài hát 

phục vụ cho giáo viên từ 

http://www.education.com/


 

 mầm non đến trung học cơ 

sở 

https://alison.com/careers/education/early- 

education-teacher 

https://www.cceionline.com/professional- 

development-courses-teacher/ 

Các khóa học, mô đun về 

kiến thức, kĩ năng chăm 

sóc và giáo dục trẻ cho 

GVMN, bao gồm các kiến 

thức chung về đặc điểm sự 

phát triển của trẻ mầm 

non, phương pháp giáo 

dục trí tuệ, ngôn ngữ, tình 

cảm, kĩ năng xã hội, thể 

chất, thẩm mỹ,…. 

https://www.enchantedlearning.com/home.shtml 

https://exchange.smarttech.com/ 

https://www.teachersbrain.com/ 

https://www.pppst.com/ 

Các tài liệu liên quan đến 

nội dung chương trình 

giáo dục từ cấp học mầm 

non đến phổ thông; chia sẻ 

giáo án, video bài giảng 

của GVMN và các cấp 

học khác; các hoạt động, ý 

tưởng, trò chơi đa dạng… 

2.2.3. Một số kĩ thuật tìm kiếm 

Mục 2.1.1 đã trình bày về 5 bước của hoạt động tìm kiếm tài liệu. Phần này 

giới thiệu một số kĩ thuật tìm kiếm, tức là thao tác trên các phần mềm tìm kiếm. 

 Sử dụng kết hợp các từ khóa 

Từ khóa chứa các đặc trưng của tài liệu cần tìm kiếm, vì vậy việc chọn và 

sử dụng từ khóa rất quan trọng trong việc tìm kiếm tài liệu. Thông thường thì 

khi chúng ta đưa ra càng nhiều từ khóa, theo nghĩa tài liệu chúng ta cần tìm chứa 

https://alison.com/careers/education/early-education-teacher
https://alison.com/careers/education/early-education-teacher
https://www.cceionline.com/professional-development-courses-teacher/
https://www.cceionline.com/professional-development-courses-teacher/
http://www.enchantedlearning.com/home.shtml
https://www.teachersbrain.com/
http://www.pppst.com/


những từ khóa đó, thì kết quả tìm kiếm sẽ thu gọn lại. 

- Từ khóa nên được đặt trong dấu ngoặc kép; 

- Sử dụng nhiều từ khóa (giữa các từ khóa có thể sử dụng dấu + nếu muốn 

tài liệu xuất hiện đồng thời các từ khóa hoặc nhập liên tục các từ khóa, mỗi từ khóa khác 

nhau đều đặt trong dấu ngoặc kép); 

- Thêm các thuộc tính của tài liệu muốn tìm: Ví dụ chúng ta muốn tìm tài 

liệu dạng pdf, chúng ta có thể bổ sung từ khóa là pdf; 

- Thêm các từ khóa mà chúng ta biết chắc chắn trong tài liệu chúng ta muốn 

tìm. Ví dụ khi muốn tìm thông tư của Bộ Giáo dục và Đào tạo từ Google, 

chúng ta có thể bổ sung từ khóa “TT-BGDĐT”. 

 Sử dụng các lựa chọn tìm kiếm của phần mềm tìm kiếm 

Sau khi nhập các từ khóa và bấm tìm kiếm (hoặc nhấn phím Enter), chúng 

ta có thể bổ sung thêm lựa chọn tìm kiếm cho tài liệu, để thu gọn các kết quả 

tìm kiếm với mong muốn kết quả tìm kiếm hội tụ về kết quả đạt yêu cầu tìm 

kiếm. 
 

Hình 2.2.4: Chi tiết thao tác tìm kiếm trên công cụ Google. 

Bấm chọn Hình ảnh hoặc Video để tìm được các tệp tin hình ảnh hoặc video 

có nội dung tương ứng của từ khóa. Chúng ta có thể chọn Công cụ (xem hình 

2.2.4) để bổ sung các lựa chọn khác như ngôn ngữ, thời gian. 

 Biết dừng đúng lúc và tham khảo ý kiến chuyên gia, đồng nghiệp 

Với các phần mềm tìm kiếm hiện nay, kết quả tìm kiếm thường rất nhiều, 



vì vậy chúng ta cần thực hành nhiều thao tác tìm kiếm tài liệu để nâng cao kĩ 

năng tìm kiếm và khai thác tài liệu từ Internet. Tuy vậy, không phải lúc nào 

chúng ta cũng tìm kiếm được tài liệu mong muốn. Lúc này, chúng ta không nên 

quá sa đà vào việc tìm kiếm và xử lí theo hướng khác, chẳng hạn như: 

- Tự tạo tài liệu: Nếu nội dung tìm kiếm là đơn giản (một sơ đồ, một bức 

ảnh có bố cục nhỏ,…) thì thay vì bỏ quá nhiều thời gian tìm kiếm, chúng 

ta nên tự tạo những tài liệu này; 

- Tham khảo thêm ý kiến của chuyên gia trong lĩnh vực tương ứng hoặc 

đồng nghiệp để hoạt động tìm kiếm có hiệu quả hơn. 

NỘI DUNG 3: Xây dựng tài liệu trong bồi dưỡng chuyên môn cho GVMN 

3.1. Xây dựng hình ảnh, âm thanh 

3.1.1. Vẽ sơ đồ tư duy bằng phần mềm MindMaple Classic 

3.1.1.1. Giới thiệu 

MindMaple Classic là phần mềm vẽ sơ đồ tư duy miễn phí phổ biến dành 

cho máy tính. Phần mềm được sử dụng rộng rãi trong khi thiết kế bài thuyết trình 

và thảo luận, ghi chú cá nhân, phác thảo dự án, kế hoạch,… giúp người dùng phát 

triển ý tưởng, ghi nhớ và quản lí dự án một cách khoa học. Sản phẩm của phần 

mềm có thể xuất ra nhiều định dạng, phù hợp với nhu cầu phát triển tài liệu chuyên 

môn cho GVMN. 

MindMaple Classic có một số đặc trưng cơ bản sau: 

- Giao diện sơ đồ tư duy tự nhiên: Bổ sung và di chuyển các chủ đề nhanh 

chóng như vẽ phác thảo hay ghi chú trên sổ tay, MindMaple Classic giúp người 

dùng phát triển chủ đề sáng tạo thay vì giới hạn trong những khuôn mẫu sẵn có. 

- Quản lí công việc khoa học: Tích hợp chi tiết công việc vào sơ đồ, đính 

kèm tài liệu, chỉnh sửa và lưu trực tiếp từ MindMaple Classic. 

- Công cụ vẽ sơ đồ tư duy mở rộng: Để có sơ đồ tư duy chi tiết hơn, người 

dùng có thể thêm các mối quan hệ, liên kết, file vào MindMaple Classic. 



- Tùy chỉnh: Cá nhân hóa sơ đồ tư duy bằng màu sắc, hình ảnh và hình 

minh họa. MindMaple Classic có các đối tượng để giúp việc trang trí sơ đồ 

thuận tiện. 

- Hỗ trợ nhập file và xuất file nhiều định dạng 

MindMaple Classic có thể được sử dụng trên các hệ điều hành thông dụng, 

như Windows, không yêu cầu thêm về cấu hình phần cứng. 

3.1.1.2. Cài đặt MindMaple Classic trên máy tính 

Để tải file và cài đặt phần mềm MindMaple Classic, chúng ta thực hiện theo 

các bước như sau. 

Bước 1: Tải file cài đặt 

Truy cập trang chủ của MindMaple Classic: https://www.mindmaple.com/ 

và bấm MindMaple Download để tải file cài đặt (hình 3.1.1(a)). 

Bắt đầu tải file 

Tiếp theo, cần ghi nhớ số sê-ri để cài đặt (có thể copy trực tiếp), trong trường 

hợp minh họa, số sê-ri là: 3FWH-BAUX-7YLG-VR7H; sau đó bấm theo chỉ dẫn 

trên hình 3.1.1(b). 

Bước 2: Chạy file vừa download được (click đúp vào file vừa download). 

Bước 3: Thực hiện các thao tác như trong hình 3.1.2. 

Tích chọn như trong hình 3.1.2(a) và bấm chọn Next; 

Nhập tên người dùng, số sê-ri như trong hình 3.1.2(b) và bấm chọn Next; 

Chọn Next (hình 3.1.2(c)) → Chọn Next (hình 3.1.2(d)) → Chọn Install 

(hình 3.1.2(e)); Đợi một khoảng thời gian cho phần mềm cài đặt hoàn tất, bấm 

Close (hình 3.1.2(f)). 
 

3.1.1.3. Sử dụng MindMaple Classic 

Phần mềm MindMaple Classic cung cấp giao diện và hỗ trợ các thao tác 

để xây dựng một sơ đồ tư duy như sau. 

https://www.mindmaple.com/Classic
https://www.mindmaple.com/Classic
https://www.mindmaple.com/Classic
http://www.mindmaple.com/
https://www.mindmaple.com/Classic


a) Giao diện 

Giao diện của phần mềm MindMaple Classic bao gồm 6 vùng, được gán 

nhãn A, B, C, D, E, F như trong hình 3.1.3. 
 

Hình 3.1.3: Giao diện phần mềm MindMaple Classic. 

A (File Tab): Menu (có giao diện tương tự như MS Office quen thuộc) với 

các chức năng phổ biến như tạo file mới, mở file hiện có, lưu file, in file,… 

B (Quick Access Toolbar): Là thanh công cụ truy cập nhanh với các chức 

năng thông dụng như lưu file, mở file, hoàn tác,… Chúng ta có thể thêm các chức 

năng khác vào thanh này. 

C (Ribbon Menu): Khu vực bao gồm toàn bộ chức năng của MindMaple 

và được chia thành các tab dựa trên thuộc tính và chức năng của chúng. 

D (Task Side Panel): Cung cấp một số chức năng đơn giản, cho phép người 

dùng kiểm soát từng giai đoạn phát triển của sơ đồ, ví dụ đánh dấu ưu tiên, bổ 

sung mức độ hoàn thành,… 

E (Main Map): Vùng rộng nhất trong giao diện, là nơi tạo và biên tập sơ đồ. 

F (Map Tabs): Cho phép quản lí nhiều sơ đồ đồng thời (có thể hình dung 

tương tự như các tab trong MS Excel). 

https://www.mindmaple.com/Classic


b) Tạo sơ đồ tư duy mới 

Khi bắt đầu chạy phần mềm, giao diện đầu tiên cho phép chúng ta tạo một 

sơ đồ tư duy mới bằng cách chọn themes cho chủ đề (có thể hiểu là kiểu cách, 

dạng các khối hình, màu sắc,…) hoặc chọn template (có thể hiểu là bản mẫu) 

cho chủ đề (xem hình 3.1.4). Trường hợp khác, khi đang sử dụng phần mềm, 

muốn tạo một sơ đồ tư duy mới, chúng ta chọn File → New (hoặc bấm tổ hợp 

phím Ctrl 

+ N) thì phần mềm cũng sẽ chuyển đến giao diện như hình 3.1.4 để tạo một sơ 

đồ tư duy mới. 
 

Hình 3.1.4: Chọn themes hoặc template cho sơ đồ tư duy. 

Nếu muốn bắt đầu với một sơ đồ trống (với một chủ đề trung tâm - Central 

Topic), chúng ta chọn Map Themes; Nếu muốn bắt đầu với một bản mẫu có sẵn, 

chúng ta chọn Map Template; sau đó chọn loại tương ứng và bấm OK. 

Khi tạo sơ đồ tư duy mới sẽ đồng thời tạo chủ đề trung tâm của sơ đồ 

(Central Topic). 

c) Thêm chủ đề 

Phần mềm MindMaple Classic hỗ trợ nhiều cách thêm các chủ đề. Ở đây 

chỉ minh họa cụ thể trường hợp thêm các chủ đề chính (Main Topic). Các chủ đề 

khác được thực hiện tương tự như thêm chủ đề chính. Về mặt thao tác, có thể 

https://www.mindmaple.com/Classic


xem chủ đề chính là chủ đề con (subtopic) của chủ đề trung tâm. Để thêm chủ đề 

chính vào sơ đồ, chúng ta có thể thao tác một trong các cách sau: 

1) Bấm chọn (click chọn - chuột trái) chủ đề trung tâm → Bấm phím Insert; 

2) Bấm chọn (click chọn - chuột trái) chủ đề trung tâm → Bấm phím Space; 

3) Di chuột vào chủ đề trung tâm, giữ chuột trái và kéo ra phía ngoài vùng 

chủ đề trung tâm; 

4) Bấm chọn (click chọn - chuột trái) chủ đề trung tâm, sau đó chọn Home 

→ chọn Subtopic. Các vị trí chọn chỉ ra trong hình 3.1.5(a); 

5) Click chuột phải vào chủ đề trung tâm → Chọn Insert → Chọn Subtopic 

(minh họa trong hình 3.1.5(b)); 

 

(a) (b) 

Hình 3.1.5: Minh họa thêm chủ đề cho cách 4 (hình a) và cách 5 (hình b). 

6) Bấm chọn (click chọn - chuột trái) chủ đề chính → Bấm phím Enter 

7) Bấm chọn (click chọn - chuột trái) chủ đề chính sau đó chọn Home → chọn 

Topic. Các vị trí chọn chỉ ra trong hình 3.1.6. 



 

Hình 3.1.6: Minh họa thêm chủ đề cho cách 7. 

8) Click chuột phải vào chủ đề chính → Chọn Insert → Chọn Topic 

Trong 8 cách liệt kê ở trên thì: 

- Cách 1 đến 5 là tác động trên chủ đề trung tâm, là gốc của chủ đề chính; 

- Cách 6 đến 8 là tác động trên chủ đề chính cùng chung gốc với chủ đề 

chính tạo ra. 

Chúng ta có thể áp dụng những cách như đã liệt kê ở trên để tạo ra các chủ 

đề nhánh khác trong sơ đồ. 

Đối với chủ đề gốc, cụ thể là thêm chủ đề gốc của một chủ đề đã có, chúng 

ta không áp dụng một trong tám cách trên mà thực hiện một trong hai cách sau: 

- Bấm chọn (click chọn - chuột trái) vào chủ đề mà ta muốn thêm chủ đề 

gốc cho nó, sau đó bấm tổ hợp phím Ctrl + Shift + Insert; 

- Click chuột phải vào chủ đề mà ta muốn thêm chủ đề gốc cho nó → Chọn 

Insert → Chọn Parent Topic (hình 3.1.7). 



 

Hình 3.1.7: Minh họa thêm chủ đề gốc cho một chủ đề đã có. 

Với cách bấm chuột phải và chọn Insert này, chúng ta có thể thêm topic độc 

lập (Floating Topic) hay mô tả thêm cho Topic nào đó (Insert → Callout Topic). 

d) Chỉnh sửa một chủ đề 

Thao tác chỉnh sửa một chủ đề tương tự như thao tác trên một ô có chữ trong 

MS Word hoặc MS PowerPoint. 

- Để thay đổi nội dung của chủ đề, chúng ta click đúp vào chủ đề và nhập 

vào nội dung cần thay đổi. 

- Để chỉnh sửa chủ đề, chúng ta chọn chủ đề (bấm chuột trái vào chủ đề) 

→ Bấm chọn thẻ Style trên Ribbon Menu và chọn chức năng tương 

ứng như chọn font chữ, màu chữ; chọn hình dạng chủ đề, chọn màu nền chủ đề; chọn 

dạng, độ dày, màu sắc của nhánh;… 

e) Di chuyển chủ đề 

Đưa con trỏ chuột đến chủ đề cần di chuyển, lúc xuất hiện dấu mũi tên chéo 

(như đánh dấu trong hình sau) thì bấm chuột trái và kéo đến vị trí mới như mong 

muốn của người thiết kế. 



 

 

Nếu vị trí mới của chủ đề trùng với một chủ đề khác (gọi là chủ đề A chẳng 

hạn) thì chủ đề di chuyển sẽ trở thành chủ đề con của chủ đề A. 

f) Xóa chủ đề 

Nếu muốn xóa một chủ đề và tất cả các chủ đề con của nó, chúng ta chọn 

chủ đề (click chuột trái vào chủ đề đó) đó và nhấn phím Delete. 

Nếu muốn xóa một chủ đề mà không xóa các chủ đề con của nó, chúng ta 

chọn chủ đề đó và nhấn tổ hợp phím Ctrl + Shift + Delete. 

g) Thêm thông tin cho chủ đề 

Chúng ta có thể thêm thông tin cho chủ đề, các thông tin có thể thêm là 

ảnh, liên kết, ngày tháng, các kí hiệu thể hiện mức độ ưu tiên, mức độ hoàn 

thành công việc, các cờ,… Các thông tin được thêm bằng cách chọn chủ đề 

(bấm chuột trái vào chủ đề) → Bấm chọn thẻ Insert trên Ribbon Menu và chọn 

chức năng tương ứng. 

h) Lưu file và xuất sơ đồ sang các định dạng khác nhau 

Bấm tổ hợp phím Ctrl + S để lưu sơ đồ hoặc vào File → chọn Save/Save as 

→ chọn thư mục để lưu → đặt tên file trong ô File name → chọn kiểu file muốn 

lưu tại ô File type → bấm Save như lưu trữ các file thông thường. 

Phần mềm MindMaple Classic hỗ trợ việc xuất sơ đồ tư duy sang các định 

dạng khác nhau như MS Word, MS Excel, MS PowerPoint, HTML, ảnh hoặc 

văn bản (text) rất thuận tiện cho các mục đích sử dụng khác nhau. Để xuất sơ đồ 

sang dạng ảnh, chúng ta thực hiện như sau: 

Vào File → chọn Export → chọn Export as Image → chọn thư mục để 

lưu file sau khi xuất → đặt tên file ảnh trong ô File name → bấm Save → Chọn 

kích thước ảnh và bấm OK. 

https://www.mindmaple.com/Classic


Việc xuất sang các định dạng khác được thực hiện tương tự. 

3.1.2. Chuyển đổi văn bản thành giọng nói sử dụng Viettel AI 

3.1.2.1. Giới thiệu 

Có nhiều phần mềm để chuyển đổi văn bản thành giọng nói. Chúng ta nên 

sử dụng các phần mềm trên điện thoại di động hoặc trực tuyến để đảm bảo phần 

mềm thường xuyên được cập nhật những tính năng mới nhất. Phần này hướng 

dẫn sử dụng công cụ chuyển đổi văn bản thành giọng nói của Viettel tại địa chỉ: 

https://viettelgroup.ai/service/tts. Đây là nền tảng Công nghệ trí tuệ nhân tạo cho 

xử lí tiếng Việt, được cung cấp bởi tập đoàn Viettel. 

Nền tảng Công nghệ trí tuệ nhân tạo của Viettel cung cấp công nghệ trí tuệ 

nhân tạo về xử lí tiếng nói, thị giác máy tính và xử lí ngôn ngữ tự nhiên. Công 

nghệ xử lí tiếng nói bao gồm tổng hợp tiếng nói và nhận dạng tiếng nói. Công 

nghệ tổng hợp tiếng nói là công nghệ cho phép tự động chuyển đổi văn bản thành 

tiếng nói Tiếng Việt với các đặc trưng sau: 

- Cho giọng đọc tự nhiên, ngắt nghỉ tự động và kết hợp biểu cảm chính xác; 

- Cung cấp giọng đọc báo, đọc truyện với cả 3 vùng miền: Miền Bắc, miền 

Trung và miền Nam; mỗi vùng miền có giọng đọc nam và nữ; 

- Có thể điều chỉnh tốc độ đọc; 

- Cho phép tải file âm thanh về máy tính với các định dạng mp3, wav. 

3.1.2.2. Đăng kí tài khoản 

Truy cập vào địa chỉ: https://viettelgroup.ai/service/tts và chọn đăng kí để 

bắt đầu thực hiện đăng kí tài khoản (hình 3.1.8(a)). Tại giao diện đăng kí, chúng 

ta khai báo họ tên, email, mật khẩu (mật khẩu cho trang này, không cần trùng 

với mật khẩu email), tích chọn và bấm đăng kí như hình 3.1.8(b). Có thể hệ thống 

sẽ yêu cầu chúng ta làm một số thao tác để xác thực chúng ta không phải là rô 

bốt. 

https://viettelgroup.ai/service/tts
https://viettelgroup.ai/service/tts


Tiếp theo, hệ thống sẽ thông báo việc đăng kí thành công và yêu cầu kiểm 

tra email để xác thực email (hình 3.1.8(c)). Chúng ta cần mở email để xác thực 

email và truy cập vào trang Viettel AI (hình 3.1.8(d)). 
 

3.1.2.3. Chuyển đổi văn bản thành giọng nói 

Từ trang chủ chúng ta bấm chọn Tổng hợp tiếng nói (hình 3.1.9(a)). 

Tiếp theo chọn Trải nghiệm → Nhập văn bản (có thể copy và dán từ một 

đoạn văn bản chuẩn bị trước) → Chọn giọng đọc và chọn Tốc độ đọc → Bấm 

chọn Đọc văn bản (hình 3.1.9(b)). 
 

(a) 

 

 

(b) 

Hình 3.1.9: Thiết lập để thực hiện chuyển đổi văn bản thành giọng nói. 

Đợi một thời gian ngắn để hệ thống đọc xong văn bản, chúng ta đồng thời 

nghe để đánh giá chất lượng âm thanh. Nếu hài lòng với đoạn âm thanh đã có 

thì bấm Tải xuống và chọn một định dạng file để tải file về máy tính (hình 

3.1.10). 



 

Hình 3.1.10: Tải file âm thanh về máy tính. 

Để chất lượng âm thanh được tốt, ngữ điệu đọc phù hợp với đoạn văn bản, 

chúng ta cần: 

- Cho hệ thống đọc từng đoạn văn bản ngắn, 

- Viết đoạn văn bản đúng ngữ pháp, 

- Nên viết thẳng phiên âm những từ hoặc cụm từ viết tắt. 

3.1.3. Sử dụng phần mềm Audacity 

3.1.3.1. Giới thiệu 

Audacity là một phần mềm thu âm chuyên nghiệp, hoàn toàn miễn phí trên 

máy tính, laptop và dễ sử dụng. Ngoài khả năng thu âm trực tiếp bằng micro, phần 

mềm còn cung cấp bộ công cụ giúp loại bỏ tạp âm không mong muốn trong quá 

trình thu âm, cũng như chỉnh sửa tệp sau khi thu âm. 

Phần mềm Audacity có các tính năng sau: 

- Có thể thu âm trực tiếp bằng micro, bộ thu kết hợp thiết bị, hay các thiết 

bị thu âm khác tương tự; 

- Dễ dàng điều chỉnh âm lượng ngay trong quá trình thu âm; 

- Ghép, chỉnh sửa nhiều bản thu âm; 

- Khả năng lọc, loại bỏ tạp âm vượt trội so với các phần mềm thu âm cơ bản; 

- Dễ sử dụng đối với những người mới bắt đầu; 



- Hỗ trợ tiếng Việt và hoàn toàn miễn phí; 

- Nhập file: Nhập file mp3; xuất ra nhiều định dạng: mp3, wav, goo... 

Phần mềm Audacity có thể được sử dụng trên các hệ điều hành thông dụng, 

như Windows, không yêu cầu thêm về cấu hình phần cứng. 

3.1.3.2. Cài đặt phần mềm Audacity trên máy tính 

Bước 1: Tải file cài đặt 

Truy cập link: https://www.audacityteam.org/download và bấm Download 

for Windows (hình 3.1.11). 
 

Hình 3.1.11: Tải file cài đặt phần mềm Audacity. 

Bước 2: Chạy file vừa download được (click đúp vào file vừa download). 

Bước 3: Tích chọn Vietnamese như trong hình 3.1.12 để chọn ngôn ngữ là 

tiếng Việt và bấm chọn OK. 
 

https://www.audacityteam.org/download


 

Hình 3.1.12: Chọn ngôn ngữ tiếng Việt khi cài đặt phần mềm Audacity. 

Bước 4: Tiếp tục cài đặt với phần giao diện là tiếng Việt, nếu cài đặt theo 

chế độ mặt định của phần mềm thì chỉ cần bấm Tiếp liên tục → bấm Cài đặt 

→ bấm Hoàn thành. 

3.1.3.3. Thu âm 

Để tiến hành thu âm với phần mềm Audacity thì máy tính hay laptop cần 

phải có micro thu âm. Có thể sử dụng micro laptop, micro headphone hoặc là 

microphone để thu âm. 

Từ giao diện chính của phần mềm, chúng ta bấm (click trái chuột) vào biểu 

tượng có dấu tròn màu đỏ để bắt đầu thu âm (hình 3.1.13). 
 

Hình 3.1.13: Bắt đầu thu âm bằng phần mềm Audacity. 

Bên cạnh nút bấm để thu âm có các nút có kí hiệu quen thuộc như trên các 



phần mềm nghe nhạc hay thiết bị nghe nhạc, chúng ta sử dụng các nút này để tạm 

dừng thu âm, dừng thu âm, nghe thử đoạn vừa thu âm,… Khi di chuột đến 

các nút này, chức năng của nó sẽ hiển thị như trong hình 3.1.14. 
 

Hình 3.1.14: Các nút điều khiển trong thu âm bằng phần mềm Audacity. 

Khi thu âm, chúng ta nên để một khoảng 3-5 giây đầu tiên của bản thu âm 

yên lặng (không nói gì); chúng ta sẽ sử dụng khoảng yên lặng này khi thực hiện 

chức năng lọc nhiễu như trình bày trong phần tiếp theo. 

3.1.3.4. Lọc nhiễu 

Trong quá trình thu âm, có thể có một số tạp âm trong file âm thanh. Để tiến 

hành giảm phần tạp âm này, chúng ta thực hiện theo các bước sau: 

Bước 1: Bôi đen khoảng “yên lặng” bằng cách nhấn chuột trái rồi kéo để chọn. 

Bước 2: Click vào Hiệu ứng → [Noise Removal and repair - xóa và sửa 

nhiễu - tiếng ồn] → [Noise Reduction-Giảm nhiễu...] (hình 3.1.15) 
 

Hình 3.1.15: Minh họa bước 2 của lọc nhiễu bằng phần mềm Audacity. 



Bước 3: Click chọn Nhận dữ liệu tiếng ồn (hình 3.1.16) 
 

 

Hình 3.1.16: Minh họa bước 3 của lọc nhiễu bằng phần mềm Audacity. 

Bước 4: Chọn toàn bộ track âm thanh cần lọc nhiễu bằng cách nhấn tổ hợp 

Ctrl+A hoặc nhấn chuột trái để kéo. 

Bước 5: Thực hiện lại thao tác như trên hình 3.1.15. 

Bước 6: Lúc này phần mềm sẽ nhận giao diện như hình 3.1.16, bấm OK 

Kết quả, chúng ta sẽ thu được file âm thanh có ít nhiễu và tạp âm hơn. 

3.1.3.5. Biên tập, chỉnh sửa, cắt ghép, xuất file âm thanh 

a) Nhập một file âm thanh 

Để mở một file âm thanh vào trình làm việc của phần mềm Audacity, chúng 

ta chọn Tập tin → chọn Mở (hoặc nhấn tổ hợp phím Ctrl + O) rồi tìm chọn vào 

file âm thanh và bấm Open (hoặc click đúp vào file âm thanh). Thao tác mở một 

file âm thanh tương tự như mở file trong các phần mềm MS Office. 

Để nhập thêm một file âm thanh, chúng ta chọn Tập tin → Nhập → Âm 



thanh… rồi thao tác tương tự như khi mở file âm thanh. 

b) Cắt file âm thanh 

Phần này giới thiệu 3 thao tác có thể được sử dụng để cắt file âm thanh: 

- Cắt bỏ một đoạn âm thanh được chọn từ một file; 

- Cắt phần còn lại, chỉ lấy đoạn âm thanh được chọn; 

- Chia file âm thanh thành các file khác nhau, sau đó xử lí độc lập trên các 

phần khác nhau (xóa bỏ hoặc giữ lại). 
 

Hình 3.1.17: Chọn và cắt bỏ đoạn âm thanh bằng phần mềm Audacity. 

Cả ba thao tác này đều có một bước chung, đó là Chọn đoạn âm thanh: 

Chúng ta di chuột đến đầu đoạn âm thanh cần chọn, sau đó giữ chuột trái và kéo 

sang phải đến cuối đoạn âm thanh cần bỏ; hoặc thao tác ngược lại; Để xác định 

chính xác đoạn âm thanh cần bỏ, chúng ta có thể sử dụng chức năng nghe đoạn 

âm thanh. Sau khi chọn, ta được giao diện như hình 3.1.17. 

 Để cắt bỏ đoạn âm thanh được chọn, chúng ta nhấn phím Delete trên 

bàn phím hoặc nhấn tổ hợp phím Ctrl + X hoặc nhấn chuột phải vào đoạn âm 

thanh được chọn và chọn Cắt. 

 Để cắt bỏ hai phần âm thanh hai bên, chỉ giữ lại đoạn được chọn, chúng 



ta bấm vào biểu tượng như đã chỉ ra trong hình 3.1.17, hoặc nhấn tổ hợp phím 

Ctrl + T. 

 Chúng ta có thể bấm chuột phải vào đoạn âm thanh, sau đó chọn Tách 

Clip để chia file âm thanh thành 3 file khác nhau, sau đó có thể xử lí độc lập trên 

3 đoạn âm thanh độc lập. 

c) Ghép các file (đoạn) âm thanh 

Giả sử chúng ta đang thao tác trên một file âm thanh (File 3), chúng ta muốn 

ghép một đoạn file âm thanh từ File 2 vào File 3, chúng ta làm như sau. 

Bước 1: Nhập file âm thanh 2 (Tập tin → Nhập → Âm thanh…). 

Lúc này, hai file âm thanh sẽ hiển thị trên hai track khác nhau (hình 3.1.18). 

 

Hình 3.1.18: Ghép đoạn âm thanh bằng phần mềm Audacity. 

Bước 2: Chọn đoạn âm thanh từ track 2 muốn chèn vào track 1 (xem lại thao 

tác chọn đoạn âm thanh ở phần b); 

Bước 3: Click chuột phải vào đoạn âm thanh đã chọn, bấm Chép 

Bước 4: Di chuột đến cuối track 1, click chuột phải và bấm Dán (hoặc Ctrl 

+ V) như trên hình 3.1.18. 



Chú ý: 

- Khi nhập file (bước 1), chúng ta có thể nhập nhiều file một lúc; 

- Khi có nhiều track, việc thử âm thanh để chọn đoạn có thể khó khăn vì 

lúc đó các track được phát đồng thời. Nếu muốn chỉ nghe âm thanh trên 

track 2 để chọn đoạn cho chính xác, chúng ta tắt tiếng track 1; 

- Sau khi hoàn tất việc ghép các đoạn âm thanh, chúng ta nên xóa các track 

không cần thiết (bấm vào dấu X ở góc cao bên trái của track). 

d) Các hiệu ứng chỉnh sửa âm thanh 

Phần mềm Audacity có thể chỉnh sửa âm thanh với các hiệu ứng như khuếch 

đại, lọc,… Để sử dụng các hiệu ứng này, chúng ta chọn đoạn âm thanh → Chọn 

hiệu ứng cần thử. Với mỗi loại hiệu ứng đều có chế độ xem trước, chúng ta có 

thể kiểm tra trước khi sử dụng hiệu ứng đó với đoạn âm thanh. 

e) Xuất file mp3 trong phần mềm Audacity 

Để xuất file âm thanh, chúng ta chọn Tập tin → Chọn Xuất, tiếp theo chọn 

định dạng để xuất, chẳng hạn chọn Xuất thành định dạng mp3, rồi chọn vị trí 

để lưu file → Đặt tên file và nhấn Save → Nhấn OK để hoàn thành. 

3.3.2. Hoạt động 5: Xây dựng bài trình chiếu 

3.2. Xây dựng bài trình chiếu bằng Google Slides 

3.2.1. Giới thiệu 

Google sở hữu một hệ sinh thái các công cụ văn phòng tiện ích được nhiều 

người sử dụng. Google Slides là một trong số đó, là công cụ hỗ trợ việc xây dựng, 

biên tập các bài trình chiếu. 

Google Slides được Google cung cấp trong dịch vụ Google Drive nhằm hỗ 

trợ người dùng trong việc tạo ra các bản trình chiếu thuyết trình. Với khả năng 

dễ sử dụng với nhiều tiện ích đi kèm, Google Slides là một ứng dụng phù hợp 



cho nhiều hoạt động học tập và làm việc nói chung, cho hoạt động bồi dưỡng 

chuyên môn cho GVMN nói riêng. 

Một số lợi ích của việc sử dụng Google Slides là: 

Hoàn toàn miễn phí: Google Slides hoàn toàn miễn phí khi sử dụng tài 

khoản Google; không cần phải tốn nhiều chi phí để mua bản quyền như những 

phần mềm ứng dụng có phí khác. 

Chỉnh sửa và lưu tự động: Với Google Slides, chúng ta có thể chỉnh sửa 

và thiết kế các trang trình chiếu trực tuyến nhanh chóng. Bên cạnh đó, Google hỗ 

trợ lưu bài trình chiếu tự động, tránh được việc mất dữ liệu khi máy tính bị tắt 

nguồn hay vì một lí do nào đó. 

Cộng tác chỉnh sửa với nhiều thành viên: Chúng ta có thể dễ dàng chia 

sẻ các bài trình chiếu trên ứng dụng Google Slides đến nhiều người, để các đồng 

nghiệp hoặc nhóm cùng hỗ trợ nhau hoàn thành một bài trình chiếu chất lượng 

và nhanh chóng hơn. 

Chia sẻ an toàn: Với Google Slides, chúng ta có thể lựa chọn quyền truy 

cập đối với người được chia sẻ. Người được chia sẻ có thể được cấp quyền xem, 

bình luận, nhận xét hoặc chỉnh sửa bài trình chiếu. Tùy vào mức độ đóng góp 

của người đó trong bài trình chiếu để chúng ta lựa chọn quyền chia sẻ phù hợp. 

Nhiều công cụ hỗ trợ chuyên nghiệp: Có nhiều mẫu gợi ý chuyên nghiệp 

để chúng ta tạo nên một bài trình chiếu; các mẫu (templates) được phân chia theo 

nhiều chủ đề, tiết kiệm được nhiều thời gian phải suy nghĩ và tự thiết kế. Nhiều 

công cụ chỉnh sửa, các chức năng thêm nội dung, thêm hình ảnh, thêm video cho 

bài trình chiếu thêm sinh động Google Slides đều có, hỗ trợ chúng ta tạo nên một 

bài trình chiếu ấn tượng. 

Trong tài liệu bồi dưỡng năm 2022, mô đun CNTT6, chúng ta đã làm quen 

và thao tác trên ứng dụng Google Forms, vì vậy, phần hướng dẫn tiếp theo sẽ trình 

bày từ đăng nhập vào Google, không hướng dẫn phần tạo tài khoản. 

3.2.2. Các bước xây dựng bài trình chiếu bằng Google Slides 



Bước 1: Đăng nhập tài khoản Google: Từ trang chủ của Google, bấm chọn 

Google apps → bấm chọn Drive (hình 3.2.1). 

 

Hình 3.2.1: Hình minh họa bước 1. 

Bước 2: Bấm New → Google Slides để tạo bài thuyết trình mới (hình 3.2.2). 

 

Hình 3.2.2: Tạo bài thuyết trình mới. 

Giao diện để thiết kế bài trình chiếu như hình 3.2.3. 



 

Hình 3.2.3: Giao diện thiết kế bài thuyết trình trên Google Slides. 

Bước 3: Định dạng một bài trình chiếu 

Chọn mẫu trình bày có sẵn bằng cách chọn các Theme xuất hiện ở bên phải 

của trang trình chiếu. Sử dụng thanh cuộn để di chuyển qua các chủ đề sẵn có 

khác nhau (hình 3.2.3). Sau khi chọn được một mẫu theme phù hợp, chúng ta được 

giao diện như hình 3.2.4. Việc nhập văn bản được thực hiện tương tự như MS 

PowerPoint. Khi chúng ta chọn văn bản thì các chức năng tùy chọn mới xuất hiện 

ở thanh công cụ phía trên. Các chức năng này cho phép chỉnh sửa hình dạng của 

hộp văn bản, như màu nền và đường viền, kiểu chữ, cỡ chữ, màu sắc và các kiểu 

đậm, gạch dưới, in nghiêng. 
 



Hình 3.2.4: Bài trình chiếu khi được chọn thêm. 

Bước 4: Thêm và xoá các slide 

Để thêm slide, bấm vào biểu tượng dấu + trên cùng bên trái → Bấm chuột 

phải lên slide → chọn apply layout để chọn bố cục cho slide mới (hình 3.2.5). 
 

Hình 3.2.5: Thêm slide mới, chọn bố cục cho slide mới. 

Nhập nội dung văn bản vào các slide mới, lưu ý về cách trình bày phân cấp 

thông tin theo các mục: Tiêu đề - ý chính - nội dung. 

Slide được xóa bằng một trong các cách sau: 

- Chọn slide (bấm chuột trái vào slide muốn xóa) và nhấn phím Delete, 

- Chọn slide, sau đó chọn Edit → Delete (hình 3.2.6(a)), 

- Bấm chuột phải vào slide và bấm Delete (hình 3.2.6(b))). 



 

(a) (b) 

Hình 3.2.6: Xóa slide. 

Bước 5: Thêm tập tin đa phương tiện 

 Chèn ảnh 

Để thêm một ảnh vào slide, chúng ta chọn nút image trên thanh công cụ hoặc 

chọn Insert → Image → Chọn một trong các cách: Tải lên hình ảnh từ máy 

tính, chèn ảnh từ trang web, chèn ảnh từ Drive hoặc Google Photos; camera;... 

(xem hình 3.2.7). 
 

Hình 3.2.7: Các cách chèn ảnh vào slide. 

 Chèn video 

Tương tự việc chèn ảnh, Google Slides cho phép chèn video bằng cách chọn 

Insert → Video → Chọn một trong hai cách: Chèn từ Youtube hoặc chèn từ 



Drive. Sau khi chèn video vào slide, click chuột vào video đó sẽ cho phép chọn 

các chế độ phát video là khi có click chuột (on click), tự động (automatically) 

hoặc tự điều chỉnh. Chúng ta cũng có thể chọn thời điểm video bắt đầu và kết thúc 

bằng cách thay đổi tham số Start at và End at. 

Bước 6: Chèn các đối tượng khác 

Các đối tượng như ô văn bản, âm thanh, các dạng hình, bảng biểu, sơ đồ,… 

được chèn bằng cách chọn Insert → chọn đối tượng chèn tương ứng (hình 3.2.8). 
 

 

Hình 3.2.8: Chèn các đối tượng vào slide. 

Bước 7: Thiết lập hiệu ứng 

Để tạo hiệu ứng cho slide và đối tượng, chúng ta chọn View → Motion, hoặc 

bấm tổ hợp phím Ctrl + Alt + Shift + B (hình 3.2.9(a)), lúc đó ở phía phải trang 

thiết kế sẽ xuất hiện giao diện cho tạo hiệu ứng (hình 3.2.9(b)). Có hai loại hiệu 

ứng: hiệu ứng chuyển slide và hiệu ứng đối với các đối tượng trong slide. 
 

(a) (b) 



Hình 3.2.9: Giao diện để tạo hiệu ứng. 

 Thiết lập hiệu ứng với slide 

Ở trang màn hình chính thiết kế, chúng ta bấm chuột vào slide, lúc đó ở giao 

diện tạo hiệu ứng, chúng ta có thể thao tác với hiệu ứng slide (hình 3.2.10(a)). 

Đối với slide, chúng ta có thể lựa chọn các loại hiệu ứng chuyển slide, điều chỉnh 

thời gian nhanh chậm. Nếu muốn áp dụng hiệu ứng này cho tất cả các slide, 

chúng ta bấm chọn Apply to all slides. 
 

 

(a) 

 

(b) 

Hình 3.2.10: Tạo hiệu ứng cho slide (hình a) và đối tượng (hình b). 



 Thiết lập hiệu ứng với đối tượng trong slide 

Ở màn hình chính thiết kế, bấm chọn (chuột trái) vào đối tượng muốn tạo 

hiệu ứng; lúc đó ở giao diện tạo hiệu ứng, chúng ta có thể thao tác với hiệu ứng 

đối tượng (hình 3.2.10(b)): lựa chọn các loại hiệu ứng khác nhau, cách xuất hiện 

hiệu ứng (ví dụ xuất hiệu sau click chuột) điều chỉnh thời gian nhanh chậm. 

Trong khi thiết lập hiệu ứng cho slide và cho đối tượng, chúng ta có thể bấm 

Play để xem trước hiệu ứng. 

Bước 8: Trình chiếu, chia sẻ và tải bài trình chiếu 

Để trình chiếu slide hiện tại (slide đang trên màn hình thiết kế), bấm chọn 

Slideshow hoặc bấm tổ hợp phím Ctrl + F5. 

Để trình chiếu từ slide đầu tiên, chúng ta bấm vào mũi tên xuống ở nút 

Slideshow, sau đó chọn Start from beginning (hình 3.2.11). 
 

Hình 3.2.11: Chiếu slide trong Google Slides. 

Để chia sẻ bài trình chiếu trong Google Slides, chúng ta nhấp chọn 

nút Share màu xanh ở góc bên phải màn hình. Lúc đó, chúng ta có thể chia sẻ 

tài liệu với những người khác và có thể thiết lập cho người được chia sẻ chức 

năng chỉ xem hay có thể sửa chữa bài trình chiếu. Chúng ta đã quen với việc chia 



sẻ tài liệu trên các ứng dụng Google, phần này không có hình minh họa. 

Chúng ta có thể tải file bài trình chiếu về máy tính dưới các định dạng khác 

nhau như MS PowerPoint, pdf, ảnh,… Ví dụ để tải file với định dạng MS 

PowerPoint, chúng ta bấm File → Download → Microsoft PowerPoint, lúc 

này một file dạng MS PowerPoint, định dạng *.pptx, tên file trùng với tên tài liệu 

trên Googles Slides sẽ được tải xuống máy tính của chúng ta. 

3.3.3. Hoạt động 6: Xây dựng video 

3.3. Xây dựng video 

3.3.1. Xây dựng video trong bồi dưỡng chuyên môn cho GVMN 

Việc xây dựng video là cần thiết trong các hoạt động giáo dục nói chung 

và bồi dưỡng chuyên môn cho GVMN nói riêng nhằm khai thác những lợi thế 

của video để chuyển tải nội dung đến học viên một cách hấp dẫn, sinh động. Để 

xây dựng một video, chúng ta cần phải thực hiện các công việc sau: 

- Chuẩn bị ý tưởng, kịch bản cho video: Xuất phát từ mục đích, yêu cầu 

của việc sử dụng video, chúng ta cần phải xây dựng một kịch bản chi 

tiết cho video; 

- Chuẩn bị các nguyên liệu để xây dựng video: Sau khi có kịch bản, 

chúng ta cần thu thập (khai thác từ Internet, tự vẽ hình, tự ghi hình - 

quay video bằng camera hoặc điện thoại di động,…) các nguyên liệu để 

xây dựng video như các đoạn video, các hình ảnh, các file âm thanh,… 

cùng với những ghi chú trình tự xuất hiện của chúng trong video chúng 

ta sẽ xây dựng. Kịch bản càng chi tiết, việc sắp xếp các nguyên liệu càng chi tiết thì việc 

dựng phim sẽ càng thuận lợi; 

- Dựng video bằng phần mềm, kiểm tra và xuất video: Thông thường, 

trong khi dựng những video ngắn, chúng ta cần xem trước và kiểm tra 

cẩn thận, từ việc sắp xếp trật tự các video, hình ảnh, sử dụng âm thanh, 

sử dụng hiệu ứng âm thanh và hình ảnh,… 



Chúng ta nên tham khảo thêm nội dung hoạt động 5, tài liệu tham khảo 5 

để có thêm thông tin về cách xây dựng video cho báo cáo chuyên đề. 

3.3.2. Xây dựng video sử dụng phần mềm CapCut 

3.3.2.1. Giới thiệu 

CapCut là ứng dụng cho phép người dùng có thể chỉnh sửa video miễn phí 

trên điện thoại (hệ điều hành Android hoặc iOS), trên máy tính và trực tuyến. Đây 

là ứng dụng chỉnh sửa đơn giản nhưng lại rất chuyên nghiệp, tạo ra những video 

chất lượng cao. 

3.3.2.2. Cài đặt phần mềm CapCut trên máy tính 

Bước 1: Tải file cài đặt 

Truy cập trang chủ của CapCut: https://www.capcut.com/vi-vn/ và bấm 

Tải về cho Windows (hình 3.3.1). 
 

Hình 3.3.1: Tải file cài đặt phần mềm CupCut. 

Bước 2: Chạy file vừa download được (click đúp vào file vừa download). 

Bước 3: Tích chọn như trong hình 3.3.2(a) và bấm chọn Install now. 

Bước 4: Đợi một khoảng thời gian để cho phần mềm cài xong, giao diện 

như hình 3.3.2(b), bấm Start now để bắt đầu. 
 

https://mediamart.vn/smartphones
https://www.capcut.com/vi-vn/


 

(a) 

 

(b) 

Hình 3.3.2: Cài đặt phần mềm CupCut. 

Bước 5: Để thuận tiện trong sử dụng, chúng ta chọn ngôn ngữ Tiếng Việt 

cho phần mềm: Bấm chọn vào biểu tượng hình lục giác (hình 3.3.3(a)) → Chọn 

Settings → Chọn Language (hình 3.3.3(b)) → Chọn tiếng Việt và bấm Save. 
 

(a) 

 



(b) 

Hình 3.3.3: Chọn ngôn ngữ tiếng Việt cho phần mềm CupCut. 

Sau bước này, chúng ta đã có phần mềm sẵn sàng cho việc sử dụng, với giao 

diện tiếng Việt tiện dụng. 

3.3.2.3. Tạo dự án video mới 

Để tạo dự án video mới, chúng ta bấm vào Dự án mới  

3.3.2.4. Đưa các file vào dự án 

Để xây dựng một video, chúng ta thường chuẩn bị các đoạn video, các file 

ảnh, file âm thanh,… và lưu vào một thư mục (folder). Chúng ta có thể bổ sung 

các file này vào dự án bằng một thao tác. 

Trước hết bấm chọn Nhập (hình 3.3.4). 

Tiếp theo chúng ta chọn đường dẫn đến file (hoặc nhiều file) chúng ta muốn 

nhập → Chọn các file muốn nhập → bấm Open (hình 3.3.4). 
 

Hình 3.3.4: Đưa các file vào dự án. 

3.3.2.5. Giao diện 

Giao diện, các vùng làm việc được mô tả trong hình 3.3.5. 

Vùng A hiển thị các file đầu vào và các hiệu ứng. Các file hoặc hiệu ứng 



hiển thị tương ứng với nội dung chúng ta chọn ở phía trên của vùng A. Trong hình 

3.3.5, chúng ta vừa nhập các file đầu vào, nội dung chúng ta chọn là Phương tiện 

→ Bộ nhớ thiết bị nên hiện tại các file hiển thị ở vùng A. Thay vì chọn các file 

đầu vào do chúng ta thu thập, chúng ta cũng có thể sử dụng các thư viện hình ảnh, 

âm thanh được cung cấp bởi phần mềm. 
 

 

Hình 3.3.5: Giao diện của phần mềm CapCut. 

Vùng B (timeline): Hiển thị những nội dung, chúng ta thống nhất thuật ngữ 

là đối tượng, đưa vào video (video, ảnh, âm thanh, chữ, hiệu ứng,…). Để đưa 

một đối tượng vào timeline, chúng ta có thể thực hiện bằng cách: 

- Di chuột lên vùng A, giữ chuột trái vào đối tượng muốn thêm và kéo vào 

timeline, 

- Di chuột lên vùng A, đến file muốn thêm, lúc này, ở góc phải dưới của 

file sẽ xuất hiện dấu + màu xanh, chúng ta bấm vào biểu tượng này. 

 

Ví dụ sau khi chèn video hen.mp4 vào timeline, giao diện như hình 3.3.6. 



 

Hình 3.3.6: Giao diện của phần mềm CapCut sau khi thêm 1 video. 

Vùng C: Xem trước. Khi chúng ta chọn vào đối tượng ở vùng A hoặc vùng 

B (file video, ảnh, âm thanh,…) thì vùng C sẽ hiển thị các đối tượng đó, ví dụ 

video thì hiển thị video, file âm thanh thì phát file âm thanh. Mục đích của vùng 

này là hiển thị trước các đối tượng và hiển thị trước video chúng ta xây dựng, 

thuận tiện cho việc biên tập, sửa chữa. Như minh họa trong hình 3.3.6, video được 

chọn nên vùng C hiển thị video đó. 

Vùng D: Vùng chi tiết và chỉnh sửa. Vùng này sẽ hiển thị chi tiết và cho 

phép chỉnh sửa các đối tượng. Như minh họa trong hình 3.3.6, vùng D hiển thị 

các thông số chi tiết và có thể chỉnh sửa đối với video xuất hiện trên timeline. 

3.3.2.6. Xử lí cơ bản với video 

a) Cắt video 

Phần mềm hỗ trợ 3 kiểu cắt video: 

- Tách 1 video thành 2 video, 

- Cắt bỏ phần trước video đến vị trí chỉ định, 

- Cắt bỏ phần sau video từ vị trí chỉ định. 

Để thực hiện cắt một video, chúng ta tiến hành theo 2 bước sau: 



Bước 1: Dùng chuột kéo thanh trỏ màu trắng đến vị trí cần cắt. Cần chú ý, 

khi kéo thanh trỏ màu trắng, thời gian tương ứng sẽ hiển thị trong vùng C - xem 

trước (hình 3.3.7). 
 

Hình 3.3.7: Minh họa thao tác cắt video. 

Bước 2: Chọn một trong 3 chế độ cắt như chỉ ra trong hình 3.3.7. 

Phối hợp 3 kiểu cắt này, chúng ta có thể cắt một đoạn video từ một video 

đầu vào tại các mốc thời gian bất kỳ. 

b) Các xử lí khác 

Chúng ta có thể xử lí âm thanh của video, thay đổi tốc độ video hay chọn 



các hiệu ứng (hiệu ứng vào, hiệu ứng ra, hiệu ứng kết hợp) bằng cách chọn vào 

thanh công cụ trên vùng chi tiết của video. 

Hình 3.3.8: Vùng chi tiết của một video. 

3.3.2.7. Xử lí cơ bản với hình ảnh 

Để chèn một ảnh vào video, chúng ta kéo ảnh vào timeline. 

a) Điều chỉnh thời gian xuất hiện ảnh 

Khi chèn một ảnh vào timeline, thời gian xuất hiện ảnh là 5 giây, muốn thay 

đổi thời gian này, chúng ta thực hiện một trong hai cách sau: 

- Loại bỏ phần sau tương tự như cắt đối với video, 

- Di chuyển con trỏ chuột vào cuối ảnh cho đến lúc xuất hiện biểu tượng 

như vòng tròn trong hình 3.3.9, sau đó giữ nút trái chuột và kéo qua về 

để tăng hoặc giảm thời gian. Khi thực hiện thao tác này, thời gian tương 

ứng sẽ xuất hiện trong ảnh và trên ô xem trước. 
 

 

Hình 3.3.9: Thay đổi thời gian của một đối tượng. 

b) Các xử lí khác 

 Thay đổi vị trí, kích thước ảnh và góc quay bằng cách chọn Video → 

Cơ bản (hình 3.3.10): 



 

Hình 3.3.10: Thiết lập tỉ lệ, vị trí, góc xoay cho ảnh. 

- Ở mục tỉ lệ, chúng ta có thể dùng chuột kéo con trỏ qua về, hoặc nhập 

số vào ô %, hoặc bấm mũi tên lên xuống để thay đổi tỉ lệ, tức là phóng 

to hoặc thu nhỏ ảnh; 

- Ở mục vị trí, chúng ta có thể nhập giá trị của X để dịch chuyển ảnh qua 

phải hoặc về trái; nhập giá trị của Y để ảnh dịch lên hoặc xuống. Để thay 

đổi vị trí của ảnh, chúng ta cũng có thể nhấn chuột vào ảnh ở ô xem trước 

để kéo ảnh qua về hoặc lên xuống; 

- Ở mục xoay, chúng ta có thể xoay ảnh với góc bất kỳ bằng cách nhập 

số hoặc bấm mũi tên lên xuống. 

 Chọn hiệu ứng động cho ảnh bằng cách chọn Hiệu ứng động trên vùng 

chi tiết (hình 3.3.11). 



 

Hình 3.3.11: Tạo hiệu ứng động cho ảnh. 

- Có 3 loại hiệu ứng: Vào, ra, kết hợp tương ứng với chọn hiệu ứng cho 

ảnh xuất hiện và trước khi rời màn hình (chuyển sang khung hình khác). 

- Tương ứng với mỗi loại hiệu ứng có hai tính năng có thể chọn 

 Chi tiết hiệu ứng: Khi chúng ta chọn tên một hiệu ứng, màn xem trước 

sẽ thể hiện hiệu ứng đó để chúng ta lựa chọn; 

 Thời gian hiệu ứng (trên hình 3.3.11 là ô thời lượng): Chúng ta có 

thể nhập giá trị hoặc bấm mũi tên lên xuống để điều chỉnh. 

3.3.2.8. Xử lí cơ bản với âm thanh 

a) Tách âm thanh từ một video 

Trong quá trình xây dựng video, với một đoạn video đầu vào, chúng ta có 

thể chỉ muốn lấy phần hình ảnh (không lấy tiếng) hoặc ngược lại, lúc đó chúng 

ta sẽ xử lí theo các tình huống sau. 

Để tách âm thanh từ một video (tức là video này sẽ tách thành một video 

không có âm thanh và một phần âm thanh riêng), chúng ta thực hiện bằng cách 

nhấn chuột phải vào video muốn tách âm thanh, sau đó chọn Tách âm thanh 



(hình 3.3.12). 

 

Hình 3.3.12: Tách âm thanh của một video. 

Sau khi thực hiện thao tác này, chúng ta sẽ có một video không có âm thanh 

và một đoạn âm thanh. Hai đối tượng này độc lập, có thể xử lí độc lập với nhau. 

Chúng ta sẽ thực hiện thao tác này khi muốn sử dụng phần âm thanh của video 

độc lập với video. 

Nếu chỉ muốn sử dụng phần hình, không sử dụng phần tiếng của video 

thì có thể thực hiện tương tự, hoặc đơn giản hơn theo thao tác sau: Trong vùng 

chi tiết của file video, chọn âm thanh. Tiếp theo, ở phần âm lượng, điều chỉnh 

âm lượng bằng 0 bằng cách dùng chuột kéo con trỏ về sát bên trái (hình 3.3.13). 
 

Hình 3.3.13: Bỏ âm thanh của một video. 

b) Chèn file âm thanh vào video 

File âm thanh có thể thêm vào timeline bằng cách tương tự như đối với video 



và ảnh. Lúc đó sẽ xuất hiện thêm một dòng thời gian của file âm thanh, song song 

với dòng thời gian của video và ảnh (hình 3.3.14). 
 

 

Hình 3.3.14: Chèn file âm thanh vào video. 

Trong ô xem trước, chúng ta sẽ xem và nghe được đồng thời hình ảnh, âm 

thanh của video mà chúng ta muốn dựng. 

Các thao tác kéo qua về file âm thanh, cắt file âm thanh thực hiện tương tự 

như đối với hình ảnh hoặc video. 

Chúng ta có thể chọn nhiều nguồn file âm thanh khác nhau. Ở vùng A, 

Bấm chọn Âm thanh → Bấm chọn âm nhạc hoặc hiệu ứng âm thanh. Ứng 

với mỗi lựa chọn này sẽ có nhiều file âm thanh, chúng ta chọn vào để nghe thử, 

nếu có thể sử dụng được thì bấm dấu + để thêm vào dòng timeline (hình 3.3.15). 
 



Hình 3.3.15: Chọn và thêm âm thanh vào video. 

c) Thao tác khác với âm thanh 

Chọn vào file âm thanh muốn chỉnh sửa thông số chi tiết trên timeline, lúc 

này ở vùng chi tiết sẽ như hình 3.3.16. 
 

 

Hình 3.3.16: Thiết lập các chi tiết cho âm thanh. 

Chúng ta có thể: 

- Thay đổi âm lượng: Kéo con trỏ sang trái hoặc sang phải để tăng hoặc 

giảm âm lượng; 

- Đặt thời gian để âm thanh to dần (lúc xuất hiện) và nhỏ dần (lúc kết 

thúc): Tính năng này rất quan trọng, chẳng hạn đối với đầu video, người 

ta thường cho âm thanh to dần, để không tạo bất ngờ không hợp lí đối 

với người theo dõi video; 

- Thay đổi tốc độ của âm thanh. 

3.3.2.9. Xử lí cơ bản với chữ 



 

Hình 3.3.17: Chọn và thêm chữ vào video. 

Để chèn chữ vào video, chúng ta chọn Văn bản trên vùng A (hình 3.3.17). 

Chúng ta có thể chọn nhiều kiểu chữ (tương tự các kiểu file âm thanh). Phần này 

sẽ hướng dẫn chi tiết cách chèn chữ mặc định (hình 3.3.18): Chọn văn bản → 

Chọn thêm chữ → Chọn mặc định → Bấm dấu + để thêm chữ. 
 

Hình 3.3.18: Chọn và thêm chữ mặc định vào video. 

a) Nhập nội dung, điều chỉnh cỡ chữ, vị trí,… 

Sau khi thêm chữ mặc định (thao tác như trong hình 3.3.18), tại vùng chi 

tiết của chữ, chọn Văn bản → Cơ bản sẽ cho ra giao diện để nhập nội dung của 

dòng chữ, chọn phông chữ, cỡ chữ, màu chữ, vị trí xuất hiện trong video, góc 

xoay,… (hình 3.3.19). 



 

Hình 3.3.19: Chọn và thêm chữ vào video. 

Chúng ta cũng có thể chọn các hiệu ứng (tương tự như hiệu ứng đối với hình 

ảnh) bằng cách chọn Hiệu ứng động. 

b) Điều chỉnh thời gian xuất hiện của chữ 

 Chọn thời điểm bắt đầu xuất hiện chữ: Giữ chuột trái vào chữ trên 

timeline và kéo qua về để chọn đúng vị trí. 

 Thay đổi thời gian tồn tại chữ: Di chuyển con trỏ chuột vào cuối chữ 

cho đến lúc xuất hiện biểu tượng như vòng tròn trong hình 3.3.20, sau 

đó giữ nút trái chuột và kéo qua về để tăng hoặc giảm thời gian. Cách 

làm này tương tự như thay đổi thời gian của một ảnh. 



 

Hình 3.3.20: Thay đổi thời gian tồn tại của chữ trong video. 

3.3.2.10. Các thao tác khác 

Chúng ta có thể thực hiện các thao tác khác để bổ sung đối tượng, tạo hiệu 

ứng cho video (hình 3.3.21). 
 

Hình 3.3.21: Hình minh họa các thao tác khác. 

Khi chọn một chức năng để thêm đối tượng, chúng ta có thể điều chỉnh thời 

gian trên timeline và điều chỉnh các tham số chi tiết như vị trí, góc xoay,… trên 

vùng chi tiết. 

3.3.2.11. Xuất video 



Để xuất video, chúng ta bấm vào biểu tượng  ở góc phải cao của 

màn hình. Tiếp theo chúng ta lựa chọn các thông số và bấm Xuất. 

Sau khi phần mềm thực hiện việc xuất video xong, chúng ta bấm Mở thư 

mục để mở thư mục đang chứa video kết quả và sử dụng. 

3.3.4. Hoạt động 7: Xây dựng trò chơi học tập 

3.4. Xây dựng trò chơi học tập 

3.4.1. Xây dựng trò chơi học tập với Kahoot 

3.4.1.1. Giới thiệu 

Kahoot là trang web cho phép chúng ta thiết kế trò chơi học tập (dưới dạng 

các câu hỏi) và tổ chức chơi: Người chủ trì trò chơi thông thường là người thiết 

kế hoặc là người sử dụng trò chơi này - báo cáo viên và các người chơi thông 

thường là học viên. Các học viên có thể sử dụng máy tính hoặc điện thoại thông 

minh có kết nối Internet để chơi. 

Trò chơi học tập này có thể được thực hiện trong bồi dưỡng trực tiếp hoặc 

trực tuyến. Giao diện thiết kế trò chơi đơn giản, dễ thực hiện. Trò chơi sau khi 

thiết kế có giao diện đẹp, hấp dẫn với người chơi. 

Để thiết kế trò chơi, chúng ta cần tạo tài khoản (miễn phí hoặc trả phí); 

Những người tham gia chơi không cần phải có tài khoản. Với tài khoản miễn phí, 

người thiết kế sẽ bị giới hạn ở một số nội dung, như dạng câu hỏi và số lượng 

người có thể tham gia chơi. Phần tiếp theo hướng dẫn chúng ta cách đăng kí tài 

khoản miễn phí, thiết kế trò chơi và tổ chức trò chơi. 

3.4.1.2. Đăng kí tài khoản 

Để đăng kí tài khoản, chúng ta truy cập vào trang web của Kahoot tại địa 

chỉ https://kahoot.com/, bấm chọn sign up để bắt đầu đăng kí (hình 3.4.1). 

https://kahoot.com/


 

Hình 3.4.1: Bấm Sign up để bắt đầu đăng kí tài khoản. 

Tiếp theo, Chọn loại tài khoản là Teacher → Chọn mô tả nơi làm việc → 

Nhập địa chỉ email và mật khẩu (mật khẩu tạo cho trang này, không nhất thiết 

trùng với mật khẩu email) → Chọn loại tài khoản miễn phí như hình 3.4.2. 
 

 

(a) Bấm Teacher để chọn tài khoản giáo viên 

 

 

(b) Bấm School để chọn mô tả nơi làm việc 



 

(c) Nhập email, mật khẩu và bấm Sign up 

 

 

(d) Bấm continue for free để sử dụng tài khoản miễn phí 

Hình 3.4.2: Đăng kí tài khoản Kahoot. 

3.4.1.3. Thiết kế trò chơi 

Thiết kế trò chơi trên Kahoot được thực hiện bằng cách thiết kế một số câu 

hỏi theo kịch bản của chúng ta, theo các bước sau. 

Bước 1: Chọn Create → Chọn Kahoot hoặc chọn Create a Kahoot (xem 

hình 3.4.3(a)), kết quả cho ra giao diện như hình 3.4.3(b). 

Bước 2: Chọn Create, như hình 3.4.3(b). 



 

(a) 

 

(b) 

Hình 3.4.3: Bắt đầu tạo một trò chơi mới trên Kahoot. 

Sau thao tác này, chúng ta có giao diện để thiết kế các câu hỏi (hình 3.4.4). 

 

Hình 3.4.4: Giao diện thiết kế câu hỏi. 

Bước 3: Thiết kế các câu hỏi 

Với mỗi câu hỏi, chúng ta có giao diện thao tác và lựa chọn như sau. 

Trước hết, chúng ta nên chọn dạng câu hỏi: Có một số dạng câu hỏi để 



kiểm tra kiến thức (Test Knowledge) hoặc để thu thập ý kiến của học viên 

(Collect Opinions). Dạng câu hỏi sẽ quyết định phần nội dung chúng ta cần nhập 

vào. 

Ví dụ: Đối với dạng câu hỏi trắc nghiệm có 4 lựa chọn, chúng ta sẽ nhập 

câu hỏi và 4 đáp án. Đối với dạng câu hỏi đúng sai, chúng ta chỉ cần nhập câu 

hỏi. Hình 3.4.3 là giao diện ứng với dạng câu hỏi trắc nghiệm 4 lựa chọn. 

Phần nội dung câu hỏi và các lựa chọn trả lời: Chúng ta có thể nhập văn 

bản trực tiếp, hoặc copy và dán nội dung từ một file đã chuẩn bị trước. 

Phần chèn hình ảnh, đoạn nhạc, đoạn video: Có thể có hoặc không. Trong 

một số trường hợp, chúng ta có thể sử dụng phần này là một nội dung hỏi, ví dụ 

đối với câu hỏi “hãy xác định nhân vật chính trong đoạn video sau”, thì chúng 

ta sẽ chọn một đoạn video nội dung để học viên xem và trả lời câu hỏi. 

Chọn đáp án đúng cho phần trả lời câu hỏi: Cần chú ý, khi nhập các câu 

trả lời, đồng thời chúng ta sẽ chọn đáp áp đúng. Số lượng đáp án đúng có thể là 

một hoặc nhiều, tương ứng với lựa chọn số đáp án là Single Select hay Multi- 

Select, như hình 3.4.5. 
 

Hình 3.4.5: Lựa chọn dạng câu hỏi một hoặc nhiều đáp án. 

Sau khi hoàn thành một câu hỏi, ví dụ câu hỏi trong hình 3.4.6(a), có hình 

minh họa là hình con mèo, đáp án đúng là đáp án “con mèo”, chúng ta nên xem 

trước câu hỏi bằng cách nhấn vào nút Preview. 
 



 

(a) Bấm Preview để xem trước 

 

(b) Bấm Exit preview để về giao diện thiết kế 

Hình 3.4.6: Lựa chọn dạng câu hỏi một hoặc nhiều đáp án. 

Hình 3.4.6(b) là hình xem trước câu hỏi. Để trở về giao diện thiết kế, chúng 

ta bấm chọn Exit Preview. Nếu chưa hài lòng về câu hỏi, chúng ta có thể sửa 

chữa; nếu đã hài lòng về câu hỏi, chúng ta tiếp tục tạo câu hỏi mới. 

Bước 4: Thêm câu hỏi 

Để thêm câu hỏi, chúng ta bấm chọn Add question (hình 3.4.7). 



 

Hình 3.4.7: Thêm câu hỏi vào trò chơi. 

Lúc đó sẽ có dạng câu hỏi cho chúng ta lựa chọn. Khi chúng ta di chuột lên 

các dạng câu hỏi thì hình thức của câu hỏi sẽ hiển thị ở ô tương ứng (hình 3.4.7). 

Nếu muốn dạng câu hỏi nào, chúng ta chỉ cần bấm chọn để thiết kế câu hỏi tiếp 

theo và thực hiện như bước 3. 

Sau khi hoàn tất các câu hỏi theo đúng kịch bản chúng ta cần, chúng ta cần 

lưu lại và đặt tên gợi nhớ để sử dụng. 

Bước 5: Lưu trò chơi 

Để lưu trò chơi vừa tạo, chúng ta bấm vào Save → Nhập tên trò chơi và 

mô tả trò chơi (nếu cần thiết) → Bấm Continue (xem hình 3.4.8). 
 

(a) 



 

 

 

 

3.4.1.4. Tổ chức trò chơi 

(b) 

Hình 3.4.8: Lưu trò chơi. 

Để tổ chức trò chơi trong lớp bồi dưỡng, chúng ta tiến hành như sau. 

Bước 1: Thông báo với học viên về trò chơi 

Bước 2: Trong mục My Kahoot, chọn gói câu hỏi chúng ta muốn bắt đầu 

trò chơi và bấm vào nút Play, sao đó chọn Classic Mode ở giao diện tiếp theo 

(hình 3.4.9). 



 

 

(a) Chọn trò chơi đã thiết kế và bấm Start 

 

(b) Bấm chọn Classic mode 

Hình 3.4.9: Bắt đầu tổ chức trò chơi. 

Lúc này, ở trang web sẽ dẫn đến một giao diện như hình 3.4.10. Chúng ta sẽ 

sử dụng thông tin ở giao diện này để hướng dẫn người chơi tham gia. 
 

Hình 3.4.10: Giao diện cung cấp thông tin cho người chơi đăng nhập. 

Bước 3: Hướng dẫn người chơi tham gia trò chơi bằng điện thoại hoặc máy 

tính có kết nối Internet. 

- Truy cập link: https://kahoot.it/ và nhập mã PIN (ví dụ mã PIN ở trên là 

https://kahoot.it/


6693079) hoặc quét mã QR 

- Nhập tên và bấm OK, go! 

Bước 4: Bấm Start để bắt đầu chơi (hình 3.4.10). 

3.4.2. Xây dựng trò chơi học tập với Quizizz 

3.4.2.1. Giới thiệu 

Quizizz là một trang web cho phép chúng ta thiết kế trò chơi học tập (dưới 

dạng các câu hỏi, bài tập trắc nghiệm) và tổ chức chơi: Người chủ trì trò chơi 

thông thường là người thiết kế hoặc là người sử dụng trò chơi này - báo cáo viên 

và các người chơi thông thường là học viên. Các học viên có thể sử dụng máy tính 

hoặc điện thoại thông minh, có kết nối Internet, để chơi. Ngoài ra, Quizizz cho 

phép chúng ta tiếp cận ngân hàng câu hỏi đa dạng hoặc tự tạo lập bộ câu hỏi phù 

hợp với mục đích sử dụng. Tương tự như Kahoot, trò chơi này có thể được thực 

hiện trong bồi dưỡng trực tiếp hoặc trực tuyến. 

Để thiết kế trò chơi, chúng ta cần tạo tài khoản (miễn phí hoặc trả phí). Với 

tài khoản miễn phí, người chơi có thể sử dụng tài khoản Google (gmail), sử dụng 

địa chỉ email,… của mình. 

3.4.2.2. Đăng kí tài khoản 

Quizizz hỗ trợ nhiều kiểu đăng kí tài khoản, phần này hướng dẫn đăng kí 

tài khoản Quizizz sử dụng tài khoản Google. Để đăng kí tài khoản, chúng ta truy 

cập vào trang web của Quizizz tại địa chỉ https://quizizz.com/ và bấm chọn Sign 

up để bắt đầu đăng kí (hình 3.4.11). 
 

https://quizizz.com/


Hình 3.4.11: Bấm Sign up để bắt đầu đăng kí tài khoản. 

Tiếp theo, Chọn Continue with Google để đăng kí sử dụng tài khoản 

Google (gmail) → Nhập tên tài khoản Google (địa chỉ gmail) và bấm Next → 

Nhập mật khẩu tài khoản Google (gmail) và bấm Next → Bấm School để chọn 

nơi sử dụng 

→ Bấm a Teacher để chọn sử dụng Quizizz với tư cách giáo viên → Bấm chọn 

Yes (hình 3.4.12). 
 

 

(a) Chọn Continue with Google để đăng kí sử dụng tài khoản Google (gmail) 
 

(b) Nhập tên tài khoản Google (địa chỉ gmail) và bấm Next 
 

(c) Nhập mật khẩu tài khoản Google (gmail) và bấm Next 
 

(d) Bấm School để chọn nơi sử dụng 



 

(e) Bấm a Teacher để chọn sử dụng Quizizz với tư cách giáo viên 
 

(f)  

Hình 3.4.12: Đăng kí tài khoản Quizizz. 

3.4.2.3. Thiết kế trò chơi 

Để thuận tiện cho việc sử dụng, chúng ta chuyển giao diện sang tiếng Việt: 

- Sau khi đăng kí tài khoản và đăng nhập hệ thống, chọn Settings 

- Ở phần lựa chọn ngôn ngữ, chọn Tiếng Việt (hình 3.4.13) 

- Trang web sẽ biến đổi sang giao diện tiếng Việt, bấm Lưu thay đổi 

 

Hình 3.4.13: Chọn giao diện tiếng Việt cho Quizizz. 

Quá trình thiết kế câu hỏi và lưu trò chơi được thực hiện theo các bước sau. 



Bước 1: Tạo bài kiểm tra (trò chơi) bằng một trong hai cách sau: 

- Cách 1: Từ trang chủ, bấm Tạo mới → Bấm chọn Quiz (hình 3.4.14); 

 

(a) Bấm Tạo mới 
 

(b) Bấm chọn Quiz 

Hình 3.4.14: Tạo bài kiểm tra (trò chơi) mới theo cách 1. 

- Cách 2: Từ trang chủ, bấm chọn Thư viện của tôi → Bấm chọn Tạo một 

bài quiz (hình 3.4.15); 
 

Hình 3.4.15: Tạo bài kiểm tra (trò chơi) mới theo cách 2. 

Kết quả cho ra giao diện như hình 3.4.16. Trong giao diện này, chúng ta chọn 

dạng câu hỏi phù hợp để thiết kế. 



 

Hình 3.4.16: Chọn dạng câu hỏi. 

Bước 2: Thiết kế các câu hỏi 

Ví dụ: Trong giao diện của hình 3.4.16, chúng ta chọn dạng Đa lựa chọn. 

Thao tác này cho ra giao diện tiếp theo để thiết kế các câu hỏi (hình 3.4.17). 

Với mỗi câu hỏi, chúng ta có giao diện thao tác và lựa chọn như sau. 

Trước hết, chúng ta nên chọn dạng câu hỏi: Có một số dạng câu hỏi để 

đánh giá hoặc để khảo sát ý kiến của học viên. Dạng câu hỏi sẽ quyết định phần 

nội dung chúng ta cần nhập vào. 

Ví dụ dạng câu hỏi trắc nghiệm có 4 lựa chọn, chúng ta sẽ nhập câu hỏi và 

4 đáp án (lựa chọn trả lời); dạng câu hỏi điền từ, chúng ta sẽ nhập câu hỏi và đáp 

án chính xác. Hình 3.4.17 là giao diện thiết kế dạng câu hỏi Đa lựa chọn. 



 

 

 

Hình 3.4.17: Giao diện thiết kế câu hỏi. 

Phần nội dung câu hỏi và các lựa chọn trả lời: Chúng ta có thể nhập văn 

bản trực tiếp, hoặc copy và dán nội dung từ một file đã chuẩn bị trước. 

Phần chèn hình ảnh, đoạn nhạc, đoạn video: Phần này có thể có hoặc 

không. Trong một số trường hợp, chúng ta có thể sử dụng phần này làm nội dung 

câu hỏi, ví dụ đối với câu hỏi “tên loài hoa có trong đoạn video sau là gì?”, thì 

chúng ta sẽ chọn một đoạn video liên quan đến nội dung của câu hỏi để học viên 

xem và trả lời câu hỏi. Chúng ta cũng có thể chèn thêm hình ảnh cho các lựa chọn 

trả lời. 

Chọn đáp án đúng cho phần trả lời câu hỏi: Cần chú ý, khi nhập các câu 

trả lời, đồng thời chúng ta sẽ chọn đáp áp đúng. Số lượng đáp án đúng có thể là 

một hoặc nhiều, tương ứng với lựa chọn là bật hay tắt mục More than one correct 

answer. Chúng ta cũng có thể thay đổi số lựa chọn trả lời bằng cách xoá bớt lựa 

chọn trả lời tại nút thùng rác của câu hỏi đó hoặc thêm lựa chọn trả lời ở phần dấu 

cộng bên phải các đáp án. Trong hình 3.4.17, số lượng lựa chọn trả lời là 4, chúng 

ta có thể xóa bớt hoặc thêm theo chỉ dẫn trên hình. Chúng ta cũng có thể thêm 

giải thích cho đáp án (hình 3.4.17). 



Chúng ta cũng có thể thiết lập các thông số khác như điểm của câu hỏi, thời 

gian của câu hỏi và có thể bấm để xem trước câu hỏi ở giao diện người chơi 

(hình 3.4.17). 

Sau khi hoàn thành thiết kế câu hỏi, chúng ta bấm Lưu để lưu câu hỏi 

vừa tạo (hình 3.4.17). 

Bước 3: Thêm câu hỏi 

Sau khi lưu câu hỏi vừa thiết kế, giao diện có được như hình 3.4.18. 

 

Hình 3.4.18: Bấm Tạo một câu hỏi mới để thêm câu hỏi. 

Lúc đó sẽ có nhiều dạng câu hỏi cho chúng ta lựa chọn. Khi chúng ta di chuột 

lên các dạng câu hỏi thì hình thức của câu hỏi sẽ hiển thị ở ô tương ứng bên phải 

(xem lại hình 3.4.16). Nếu muốn chọn dạng câu hỏi nào, chúng ta chỉ cần bấm 

vào dạng đó để thiết kế câu hỏi tiếp theo như bước 2. 

Sau khi hoàn tất các câu hỏi theo đúng kịch bản, chúng ta cần lưu lại và 

đặt tên gợi nhớ để sử dụng. 

Bước 4: Lưu trò chơi 

Sau khi lưu từng câu hỏi: Nếu chúng ta không muốn thêm câu hỏi (bước 

3) mà muốn lưu trò chơi thì thực hiện như sau. 

- Bấm Lưu để bắt đầu lưu trò chơi (hình 3.4.19); 



 

Hình 3.4.19: Bấm vào Lưu để bắt đầu lưu trò chơi. 

- Ở giao diện hình 3.4.20, chúng ta lần lượt nhập tên trò chơi, nhập lĩnh vực 

hoặc môn học, nhập lớp, bậc học, chọn ngôn ngữ, chọn hình thức hiển 

thị và nhập ảnh bìa (ảnh đại diện cho trò chơi, có thể nhập hoặc không). Sau khi nhập các 

thông số, bấm Tiếp tục để hoàn tất lưu trò chơi. 
 

Hình 3.4.20: Thiết lập các thông số và lưu trò chơi. 

3.4.2.4. Tổ chức trò chơi 

Để tổ chức trò chơi trong lớp bồi dưỡng, chúng ta tiến hành như sau. 

Bước 1: Thông báo với học viên về trò chơi 

Bước 2: Trong mục Thư viện của tôi, bấm chọn trò chơi chúng ta muốn 

tổ chức chơi, sau đó chọn Bắt đầu quiz trực tiếp → bấm chọn Thông thường 

(hình 3.4.21(a)). Ở giao diện tiếp theo, bấm chọn Tiếp tục (hình 3.4.21(b)). 



 

(a) 
 

(b) 

Hình 3.4.21: Bắt đầu tổ chức trò chơi. 

Lúc này, ở trang web sẽ dẫn đến một giao diện như hình 3.4.22. Chúng ta 

sẽ sử dụng thông tin ở giao diện này để hướng dẫn người chơi tham gia. 
 

Hình 3.4.22: Giao diện cung cấp thông tin cho người chơi đăng nhập. 



Bước 3: Hướng dẫn người chơi tham gia trò chơi bằng điện thoại hoặc máy 

tính có kết nối Internet. 

- Truy cập link: joinmyquiz.com và nhập mã tham gia trò chơi (ví dụ mã 

ở trên là 302914) hoặc quét mã QR hoặc nhận link từ người tổ chức, 

trong trường hợp này là https://quizizz.com/join?gc=302914. 

- Nhập tên và bấm Bắt đầu 

Bước 4: Bấm Bắt đầu để bắt đầu chơi (hình 3.4.22). 

  

https://kahoot.it/
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PHỤ LỤC 

Đáp án cho các câu hỏi trắc nghiệm (mục 6.1) 

 

Câu hỏi Đáp án 

1 C 

2 C 

3 A; C; D 

4 D 

5 A; B; D 

6 D 

7 A; C 

8 A; B; C 

9 D 

10 A; B; D 

 


